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Notice

All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sal es office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not ater, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. 'Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific’. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as“ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is“ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home el ectronic appliances, machine tools; persona electronic equipment; and industria robots.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.

“Specific™: Aircraft; agrospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.

Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Notes regarding these materials

This document is provided for reference purposes only so that Renesas customers may select the appropriate
Renesas products for their use. Renesas neither makes warranties or representations with respect to the
accuracy or completeness of the information contained in this document nor grants any license to any
intellectual property rights or any other rights of Renesas or any third party with respect to the information in
this document.
Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising
out of the use of any information in this document, including, but not limited to, product data, diagrams, charts,
programs, algorithms, and application circuit examples.
You should not use the products or the technology described in this document for the purpose of military
applications such as the development of weapons of mass destruction or for the purpose of any other military
use. When exporting the products or technology described herein, you should follow the applicable export
control laws and regulations, and procedures required by such laws and regulations.
All information included in this document such as product data, diagrams, charts, programs, algorithms, and
application circuit examples, is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas products listed in this
document, please confirm the latest product information with a Renesas sales office. Also, please pay regular
and careful attention to additional and different information to be disclosed by Renesas such as that disclosed
through our website. (http://www.renesas.com )
Renesas has used reasonable care in compiling the information included in this document, but Renesas
assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information
included in this document.
When using or otherwise relying on the information in this document, you should evaluate the information in
light of the total system before deciding about the applicability of such information to the intended application.
Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any
particular application and specifically disclaims any liability arising out of the application and use of the
information in this document or Renesas products.
With the exception of products specified by Renesas as suitable for automobile applications, Renesas
products are not designed, manufactured or tested for applications or otherwise in systems the failure or
malfunction of which may cause a direct threat to human life or create a risk of human injury or which require
especially high quality and reliability such as safety systems, or equipment or systems for transportation and
traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or undersea communication
transmission. If you are considering the use of our products for such purposes, please contact a Renesas
sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.
Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:

(2) artificial life support devices or systems

(2) surgical implantations

(3) healthcare intervention (e.g., excision, administration of medication, etc.)

(4) any other purposes that pose a direct threat to human life
Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who
elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas
Technology Corp., its affiliated companies and their officers, directors, and employees against any and all
damages arising out of such applications.
You should use the products described herein within the range specified by Renesas, especially with respect
to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or
damages arising out of the use of Renesas products beyond such specified ranges.
Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and
injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for
hardware and software including but not limited to redundancy, fire control and malfunction prevention,
appropriate treatment for aging degradation or any other applicable measures. Among others, since the
evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or
system manufactured by you.
In case Renesas products listed in this document are detached from the products to which the Renesas
products are attached or affixed, the risk of accident such as swallowing by infants and small children is very
high. You should implement safety measures so that Renesas products may not be easily detached from your
products. Renesas shall have no liability for damages arising out of such detachment.
This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written
approval from Renesas.
Please contact a Renesas sales office if you have any questions regarding the information contained in this
document, Renesas semiconductor products, or if you have any other inquiries.




Overview

The High-performance Embedded Workshop is a Graphical User Interface intended to ease the
development and debugging of applications written in C/C++ programming language and assembly
language for Renesas microcomputers. Its aim is to provide a powerful yet intuitive way of accessing,

observing and modifying the debugging platform in which the application is running.

This help explains the function as a "debugger" of High-performance Embedded Workshop.

Target System

The Debugger operates on the FoOUSB/UART or starter-kit.

Supported CPU

This help explains the debugging function corresponding to the following CPUs.
e M32C/80, M16C/80 Series
Note: In this help, the information which depends on this CPU is described as "for M32C".
e M16C/60, M16C/Tiny, M16C/20, M16C/10, R8C/Tiny Series
Note: In this help, the information which depends on this CPU is described as "for M16C/R8C".



Active X, Microsoft, MS-DOS, Visual Basic, Visual C++, Windows and Windows NT are either registered trademarks or
trademarks of Microsoft Corporation in the United States and other countries.

IBM and AT are registered trademarks of International Business Machines Corporation.

Intel and Pentium are registered trademarks of Intel Corporation.

Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.

All other brand and product names are trademarks, registered trademarks or service marks of their respective holders.

For inquiries about the contents of this document or product, fill in the text file the installer generates in the following
directory and email to your local distributor.

¥SUPPORT¥Product-name¥SUPPORT.TXT

Renesas Tools Homepage http://www.renesas.com/en/tools



Setup of Debugger

1. Features 3
1.1 Break FUNCEIONS ...eiiiiiiiiiiiiiee e ettt e e e e e ettt e e e e e e eeattaaeeeeeeesenatrareeaeeeeennnnanes 3
1.1.1 Software Breaks FUNCEION...........cooiiiiiiiiiiicc ettt e e eaaaees 3

1.2 Real-Time OS Debug@ing FUNCEION. .......ccoiciiiiiiie ettt e et e e e e e e e eannaees 3

1.3 GUI Input/Output FUNCEION ..ottt e ettt e e e e e e eaar e e e e e e e e eeanneees 4

2. Preparation before Use 5
2.1 Workspaces, Projects, and FIles ... e e eas 5

2.2 Starting the High-performance Embedded Workshop ..........coeieiiveiiiiiiiieeiieiiiiieeeee e 6
2.2.1 Creating a New Workspace (Toolchain Used) ........cccoevvieieieieoeeeeeeeeeeeeee e 7

2.2.2 Creating a New Workspace (Toolchain Not Used) ........ccooveveieveeieeeeeeeeeeeeeeeeeeeenns 12

2.3 Starting the DEDUGGET ......coooiiiiiiiei et e e e ee e e e e e tarraeeeee s 17
2.3.1 Connecting the EmuULator ............oooviiiiiiiiiiiiiiiiiiiieee ettt et e e e e e eeanns 17

2.3.2 Ending the EmMuULator...........cuvviiiiiiiiiiiiiiiiiiiiiiiiieieieeeeeteeseeeeeeeeeeeeseesessessssssssssssssssrsrerereeeree. 17

3. Setup the Debugger 18
B 70 I 0N )3 =1 o 3N 18

B 0 LY (07 6 IR =« TSSO 19

3.1.2 Debugging Information Tab ........ccccveeiiiiiiiiiiiiiiiee e 20

3. 1.3 RUN MOAE TaD....oiiiiiiiiiiiiieee ettt e e e e ettt e e e e e st eee e e e s ennnreeeeas 22

B.1.4 SCTIPE TAD ...t e e e e e e et e e e e e et ra e e e e e e e eanrraeens 23

3.2 Setting of the Communication INterface..........ccovvviiiiiiieiiiiiiiicc e 24
3.2.1 Setting of the USB INterface.......ccouvveeeiiiiiiiiiiiiee e 24

3.2.2 Setting of the Serial INterface.......cocvviiiiiiiiiiiiiiii e 25

3.3 Setup the Debugger for IMB2C ........cooiiiiiiieeee e e e e e earreeae e e 26

B T T 14 =Y 0o W D T 1 o Y= S UPPPPPPPRE 26

Tutorial

4. Tutorial 31
O I BN oo 1§ (i o) s WO UU S PRPN 31
4.2 TUSAZE .uvvvvuiueuiuruininenettueutuetenenenennannnnsannnnnenannsnsnnnssnnsnsnnnnsssnnssnssssssnsnsnnssssnsnsssssssesesesesesesesesesssssssssesnnn 32
4.2.1 Stepl : Starting the DebUZEZET ........veveiiiiiiiiiiiiiee e et 32
4.2.2 Step2 : Checking the Operation of RAM..........cccooiiiiiiiiiiieeieeciiieeeee et 33
4.2.3 Step3 : Downloading the Tutorial Program ..........ccccevvvvieeiiiiiiiieiieeeeeeeiieeeee e 34
4.2.4 Step4 : Setting a BreakPoint.......ccvveeeeiiiiiiiiiiiiee e
4.2.5 Stepb : Executing the Program ........cccooooiviiiiiiiiii et
4.2.6 Step6 : Reviewing Breakpoints ............ccoiiiiiiiiieiieieeiiiieee ettt e eeeiareeees
4.2.7 StepT : VIEWING REGISTET ..vvvviiiiiiiiiiiieee et e e e eeaarreee s
4.2.8 Step8 : VIEWING IMEIMOLY ...eeeeeiiieiiiiiiieeeeeeeeiiireeee e e e eeectee e e e e e eeeeittaeeeeeeeeeeetareeeeeeeeeeanrreeens
4.2.9 Step9 : Watching Variables........ocoiveeeeiiiiiiiiiiiiee et
4.2.10 Step10 : Stepping Through a Program
4.2.11 Stepl1 : Forced Breaking of Program EXecutions...........cccccuveereiviieniieeeiiiieeesivee e 47
4.2.12 Stepl2 : Displaying Local Variables ........ccoccoeiiiiiiiiiiiiiiee e 48
4.2.13 Stepl3 : Stack Trace FUNCEION ........cociiiiiiiiiiiiii ettt 49
4.2.74 WRAE INEXE? ..vviiiiiiieeeiiie ettt e ettt e e ettt e e rteee e s bt eeeesebeeeesssaaeesstseaeasssseesssssaeesssseaeasssseesnssees 50
Reference ol



5. Windows/Dialogs 53

5.1 RAM MONItOT WINAOW ...uviiiiiiiiiieiiiieesiiieeeciieeeeiteeestaeeeetveeessesaeeesssseeeassseeeesssseeesssseeeasssseesnssses 54
5.1.1 EXteNded MENUS ..coiiiiiiiiiiiiiiieeeeeiiiiieee e e e e ettt e e e e e et eeeesesnbaaeeeeese s snnnsaeeeeeesennnnseeeeas 55
5.1.2 Setting the RAM MONILOT ATEA.....cccccuviieereriieiiriieeeirieeeriteeestteeeeereeeeseseeeessnreeessseeesnssees 56

5.2 ASM WatCh WINAOW ....cccuviiiiiiiiiiiiiieeciieeeeiiee ettt e sttt e e ettt e e e sibaeeesatbeeeesebaeeesssaaeesssseaeessseesnsnnes 57
5.2.1 EXEeNdEA MENUS ..eoiiiiiiiiiiiiiiiee ettt e e e e ettt e e e e e ettt et e e e s e s ebaaeeeeesesssnsssaeeeesesennnnseeeeas 58

5.3 C WALCH WIIAOW ....eitiiieiiie ettt ee ettt ettt e e st eeetbe e e esabaeaesstseeeesssaeeessssaeesssseeesssseesnsnses 59
5.3.1 EXteNdEd MENUS ..ooiiiiiiiiiiiiiiieeeeeiiiteee e e e ettt e e e e e et eeeesesnbateeeeese s snsssaeeeeeesennnsreeeeas 61

5.4 SCTIPE WIILAOW ...ttt e et e e e e e e ettt r e e e e e e eeeeataseeeeeeeeeentasseeeeeeeaennes 62
5.4.1 EXEENAEA MENUS ..eoiiiiiiiiiiiiiiiee ettt e e e ettt e e e e e et ee e e s e s sbaaeeeeesesssnsssaeeeesesennnnseeeeas 63

5.5 S/W Break Point Setting WINAOW ........c.eeeeiuiiiiiiiiieeiiieeeeieseeieeeesiteeeereeeeseseeeesssseeesssseeessnes 64
5.5.1 Command Bubtomn........c.uiiiiiiiiiiiiiieeciieeeieee e siiee e et e e et ee e st eeeeebaeeesaaaeesnnseeeesssaeeennses 65
5.5.2 Setting and Deleting a Break Points from Editor(Source) Window...........ccccvevveuvenee.e. 66

5.6 GUT I/O WINAOW ...eeiuviiiiiiiieeeiiieeeeiteeestieeeeebeeeesaaeeesstseeeessseeessssaeaesssseaeasssaeesasssseesssseeesssssessnsnses 67
5.6.1 EXEeNdEd MENUS ..eoiiiiiiiiiiiiiiieeeeeiiiteee e e e ettt e e e e ettt ee e e s e s nbaaeeeeesesssnnssaeeeeeesennnsseeeeas 68

B.T MR WINAOW ..ottt ettt e ettt e e e s e sttt e e e e e e ssbbateeeeeesnssssaaeeesesannssraeeesesannes 69
5.7.2 Display the Task Status ........ccooiiiiiiiiieie et e eeeearraee s 71
5.7.3 Display the Ready QUeUe StatUs .......ccccoiiiiiiiiiiieiiiiiiiieeeeee et 75
5.7.4 Display the Timeout QUEUE StatUS.........ccoeiuvriiiiiiiiiiiiieeeee et 76
5.7.5 Display the Event F1ag Status.....cccuveviiiiiiiiiiiiiei et 78
5.7.6 Display the Semaphore StatUS.......cveeiiiiiiiiiiiiiiee e 80
5.7.7 Display the Mailbox SEatUS.......ccceiuvriieieeiiiiiiiiiee et eeeeae e e eeeeerre e e e e e eeearrreee s 82
5.7.8 Display the Data QUeUE STATUS ........eeeeeiiiiiiiiiiei et eeearreee s 84
5.7.9 Display the Cycle Handler SEAtus ..........oooeivviieiiiiiiiiiiiieeee et 86
5.7.10 Display the Alarm Handler Status ........ccccoviieiiiiiiiiiiiiiee et 88
5.7.11 Display the Memory Pool SEAtUS .........cooeiiiiiiiieiiiiiiieieeee et 89
5.7.12 Display the Task CONBEXt.......ccceeurrieeieeiiiiiiiieeeeeeeeeiitiee e e eeecitree e e e eeeeeaarreeeeeeeeeanrreeens 91

6. Table of Script Commands 93

6.1 Table of Script Commands (classified by fUnction) ..........c.ccoovveieieieeiereeeeeeeeeee e 93
6.1.1 Execution CommMANAS........uviiieiiiiiiiiiiiieeeeeiiiiiieeeeeeeesiitaeeeeseeesnnrareeeeesessssnssseeeeessesssssenes 93
6.1.2 File Operation CommMANdS ..........ccevvviiiiiiiiiiiiiieiieeeeeeeeeeeeeeeeeeeeeeeeeeeeerereeeeeeesereresersrerrrereree, 93
6.1.3 Register Operation CommandS...........ceeeereeuriiieeeeiiiiiiiierieeeeesiirreeeeeeessennreeeeeessssssseeees 94
6.1.4 Memory Operation COmMMANAS .........ceeeeeiiriiiiiireeeeiniiiiieeeeeeeesnrrreeeeeeessnnnreeeeesesnsssseeees 94
6.1.5 Assemble/Disassemble Commands..........cccvvviiiiiiiiiiiiiiiiieeeeeriieeeeeeeesirrreee e e e eeeearaeeeas 94
6.1.6 Software Break Setting Commands.........c..ccooeviiieiiiiiiiiiiie et 94
6.1.7 Script/Log File Commands.........ccccuviiiiiieiiiiiiiiieee e e e eesirreee e e e e setarreeee e e eeeesraeeeas 95
6.1.8 Program Display Commands ...........ccceeeeiiriiiiiiieeiiiiiieeeeeeeeniiireeeeeeesiinreeeeeessesnnnaeeeas 95
6.1.9 C Language Debugging CommandsS..........cccuvviiiieeiiiriiiiieiieeeeeriiieeeeeeeesiinreeeeeeesssnnseeeeas 95
6.1.10 Real-time OS Command..........cccccuriiiiieeiiiiiiiiieeeeeeeriiiereeeeeeserareeeeeeesssennseeeeesesessssseeees 95
6.1.11 Utility CommMANAS ......cuvvviiieeieiiiiiiieeeeeeeeiieeeeeeeeeeraeeeeeeeesearareeaeesessssnssaeeeesesesssssseees 96

6.2 Table of Script Commands (alphabetical 0Tder) ..........oovieviieiiiiieieeeeeeeeee et 97

7. Writing Script Files 99

7.1 Structural Elements of a SCript FILe ........ccoiiiiiiiiiiiiiiiiiriie e e eeeaans 99
7.1.1 Script CommMaANG ...ccoeeeeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 100
7.1.2 ASSIGN SEALEIMENT. ... .uuiiiiiiiieieiiiieee ettt e e ee st e e e e e e ebaereeeeeessssbareeeeeeesssssnsreaeeeenns 100
7.1.3 Conditional Stat@mMENT .......ccccuviiiiiiiiieeiiiee e e e ee e e e e e e e sebarreeeeeeennaabaraeeeeeens 100
7.1.4 Loop Statement(while,endw) and Break Statement..........cccccveevvevvevieeeeereeeeseeenene 100
7.1.5 Comment SEALEIMENTES .....ciiiiiiiiiiiiiiie et e e e e e ee e e e e siebarreeeeeessasrnsraeaeeeans 101

7.2 WIIEING EXDIESSIONS. ¢.tiiiiiieiiiiiiiieeeeeiiittte e e e ee sttt eeeeeesstareeeeeeesessaaraeseeeesessssssseaeesesssssssseaeeeenns 101
T.2.1 COMSEANTS ..eviviiiiiieeeiiiiiiiee e e e e ettt e e e ee sttt e e e e e e eesaeraaeeeeeeessssaseaeeesasssssssaeaeeeesssssssreeeeeenns 101
7.2.2 Symbols and 1aDELS ........ciiiiiiiiiiiiiiic e e e e e raeaeeeeas 102
7.2.3 MACTO VaATIADIES ...ccceiiiiiiiii ittt e e e ettt e e e e e e bae e e e e e e e sabbaaaeeeeeessssssraaeaeenns 103
7.2.4 RegisSter VATIADIES .......uviiiiiiiiiiiiieece ettt e e e e e e e e e e st ar e e e e e e e e enntnrraeeaeeens 104
7.2.5 MemOTY VATIADIES ...eviiiiiiiiieiiiiiiee ettt e et e e e e e e sebae e e e e e e e snebbaeeeeeeesssssssraaeaeenns 104
T.2.6 LINE INOS. c..eeeiiiiiiii ettt e e e ettt e e e e e et b e e e e e e e s aababeeeeesesnnstaaaaaeeeeeanabrraeaaeeans 104

ii



7.2.7 CRATaCter COMSLATILS ..vvvviiiieiiieiiiiieeeeeeeeciiiee et e e e eeeitte e e e e eeeetbaeeeeeeeeeeettaaeeeeeeeeeeasnrreeaeeeans 105

T.2.8 OPEIALOLS ...uvvvreieeeeeeeeiiteeee e e e eeeeitr e e e e ee ettt e e e e e e e eeettttaaeeeeeeeeetabaaeeeeeeeeeatrareeeeeeeeeasrreeeeeeeas 105
8. C/C++ Expressions 106
8.1 Writing C/C++ EXPIESSIONS .iiiiiiiiieiiiieeiiiiieeeitieeesiteeessteeeestreeeessseeessssseaessseeeasssseessssseeessseeens 106
8.1.1 IMmediate ValUeS.....cocouiiiiiiiie ettt e e e ettt e e e e e s e tnbeeeeeeeseannnaeeeas 106
8.1.2 SCOPE RESOIULION ....cceeiiiiiiiiiie ettt e e e et e e e e e e e e anareeens 107
8.1.3 Mathematical OPErators ..........cccivuviiiieeieeiiiiieieeeeeeciiiee e e eeeeetee e e e e e e eetarreeeeeeeeeaaraeeeees 107
T O o AN =3 U PUPP PP 107
8.1.5 RETEIOINCE . ceceiiieeiiie ettt ettt e ettt e e et e e e eta e e eeatbeeesabaee e stbeeeestbaeeetbaaeeantreeeanes 107
8.1.6 SiGN INVEISION . .uviiiiiiiieiiiiiiiee e e eeecte et e eeecte e e e e e ettt e e e e e e e eeetaaeeeeeeeeeetrrreeeeeeeeeansreeens 108
8.1.7 Member Reference Using Dot OPerator .............cooovvvvviieeeieeiiiiiniieeeeeeeeciveeeeeeeeeevvreene 108
8.1.8 Member Reference USING ATTOW .........ccooeiiiurireeeeeeeiiiieeeeeeeeeeciaeeeeeeeeeeeitnrseeeeeeeeeansseeeees 108
8.1.9 Pointers t0 MemDbDeTS........uuiiiiiiiiiiiiiieee ettt e s e e e e et a e e e e nraeee s 109
8.1.10 Parentheses
o I B AN = £ TSP PRUUURPURUPRRN
8.1.12 Casting t0 Basic TYPES ..uuueiiiiiiiiiiiiii e 109
8.1.13 Casting to tyPedef TYPES ..ccccciveiuiiiiie et e e e e e e e eeaaraeee s 110
8.1.14 Variable NAIME ....ccceiiiiiiiiiiiei ettt e e e e e sttt e e e e e sennntaaeeeeeseannnaeeens 110
8.1.15 FUNCEION NAIMNE ..eiiiiiiiiiiiiiie ettt e e e e e e e sttt ee e e e s nnnbeeeeeeeseannsaeeeas 110
8.1.16 Character CONSTANTS .....ccccviiiiciiieeeiiiieeeiteeesetieeeesreeeestreeesabeeeesbbeeesssseeessseeaesssseaeanes 110
8.1.17 Character String LAterals.........ccoiviiiiiiiiiiiiiiiee et ee e eeeearaeee s 110
8.2 Display Format of C/CH+ EXPIreSSIONS ......ccecieeiiiiiuriieeeeeeeeiiiteeeeeeeeeeitreeeeeeeeeeitvereeeeeeeeeannseeeees 111
8.2.1 ENuUmeration TYPeS ..ccciiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee et e e e e e e e e e e r e aaaaaaaaaas 111
I 5 T 1) (o g oY IO URPPUPPPPPPRt 111
LI T o) B <y o g o1t OO PPt 112
8.2.4 ATTAY TYPES ettt e e ettt e e e e e e e e e e et a e e e e e e e aaraaens 113
8.2.5 FUNCHION TYPES c.ceiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeee ettt e e e ee e e e e e e eeeseeesesesesesesssesesesareraaees 113
8.2.6 RefEreniCe TYPeS ..cccciii i e e e e e e e e e e aaareae s 113
8.2.7 Bit FIeld Ty PeS..ccciiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeee ettt e e e e e e e e e e eeeseeeseeesesesesesesesarasaraaees 113
8.2.8 When No C Symbol is FOUN ..........ooeiiiiiiiiiiiiiicceeciieee e 114
8.2.9 SYNLAX FXTOTS. .uuviiiiiiiiieiiiiiiee e e e e e e e e e e ettt e e e e e e e e arrreeens 114
8.2.10 Structure and Union TYPES.....cccouueeeiiiiiiiiiiiieiee ettt eeeeae e e e eearr e e e e e eeeaaraeee s 114
9. Display the Cause of the Program Stoppage 115
10. Attention 116
10.7 CommMmON ATEENTION ...ecueiiiiiiiieeeeciiiee e e e e eerirte e e e e eeseitbaeeeeeeeesetaraaeeeeesasssssanaeaessasssnsseseaessannsnnes 116
10.1.1 File operation 0N WINAOWS..........uuuuuururuiuiiinriiiieruininierererernrernreeeeeeere.—————————— 116
10.1.2 Area where software breakpoint can be St ...........coovvvvvveiiiiiiiiiiveeeieeieeiiieeeeee e 116
10.1.3 Get Or St C VATIADLES ...ccuevviiiiiie ettt e e e ettt et e e e e e araeeeeeeeesasbaaeeaeesesnnnns 117
10.1.4 Function name 1N Gttt e e e et e e e e e eesaeraeeeaeesessannaaeeaessesnnnnes 117
10.1.5 Option settings for download modules...........ccccveiiieiiieiiiiieeiiiee e 117
10.1.6 Debugging multi MOdULEs .......ccceiieiiiiiiiiiiiiiiee e e erree e e e e 118
10.1.7 Synchronized debUgZING.........cciiiiiiiiiiiiiieeiiiiiieee e eeriiiee e e e e e esrrreeeeeeesearreeeeeeessssnnees 118
10.1.8 RAM mONItor fUNCEION ......cocuiiiiieiiii et ettt et e e e e e eeeeereeeeeaaaeeeeaveeeas 118
10.1.9 Line assemble fUNCEION. ..........iieiiiiiiiiiie et e e e e et e e eareeeeeveeaeas 118
10.1.10 Unavailable debugging funCtions...........cc.eiieeviiiiiiiiieeiiieeeeeieee e e e 118
10.1.11 Software break fUnCION ..........coviiiiiiiie ittt e eare e eeevaeeen 118
10.2 Attention of the M32C DEbUZZET ......vviiiiiiiiiciiiie ettt et e e e e e eara e e eaaeeas 119
10.2.1 Option of C Compiler/Assembler/Linker ...........c..coovvvivviiiieeiiiiiiieeee e eeeeinns 119
10.3 Attention of the M16C/R8C DebUZZET .......ecooviiiiiiiiieeeiiie ettt et e 120
10.3.1 Options for compiler, assembler, and INKET ...........ccoovvveeiieiiiiiiiieeeeee e eeeeinns 120
10.3.2 TASKING C COMIPIIET ..uvvvuvuiiiiiiiiiiriiiiiiiiiiitatateretannrnrnnnnnnnnnnnnnnennnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnns 120
10.3.3 Cautions for RBC/TINY SEIIES ...cccvveiiiiuvieeiiiieeecieeeeeiieeeeireeeeetreeeesevaeeeetreseeeraeeenaraeaens 120
10.4 Options for compiler, assembler, and HNKeT..........ccovviiiiiiiiiiiieiiecceeceieee e 121
10.4.1 When USING NOXX .uiiiiiiiiiiiiiiiieteeeieiiieeeeeeeeiitteeeeeesentrreeeesesesssssseseasssesssssssseaessesssnses 121
10.4.2 When Using the TAR C Compiler (EW) ........cccoooviieiiieieicieeceeeeeeeee e 121

1ii



10.4.3 When Using the IAR C Compiler (ICC).........ccooveveieeeeeeeeeeeceeeeeeeeeeeeee e 122

10.4.4 When Using the TASKING C Compiler (EDE) .........ccoccoeivieiieieieieieeeeeveeeeeennas 123
10.4.5 When Using the TASKING C Compiler (CIM) ........c.ccoooovveieveeeeereeeeeeeeeeeeeeeeeeevenens 124
10.4.6 When Using the IAR EC++ Compiler (EW) .......coovevioviiieieiiieeeeeeeeeeeee e 124

iv



Setup of Debugger



(Blank Page)



1Features

1. Features

1.1 Break Functions

This debugger have the following functions.

1.1.1 Software Breaks Function

Software Break breaks the target program before execution of the command at the specified address.
This break point is called software breakpoint.

The software breakpoint is set/reset in the Editor (Source) window or in the S/W Breakpoint Setting
window. You can also disable/enable a software breakpoint temporarily.

The count of breakpoints depends on the connected MCU. When specifying two or more software
breakpoints, the breakpoint combination is based on the OR logic. (Arrival to any one of breakpoints
breaks the target program.)

1.1.1.1 Setting of software breakpoint

The software breakpoint can be set by the following windows.
o Editor (Source) Window
e S/W Break Point Setting Window

You can double-click the mouse to set/reset the software breakpoint in the Editor (Source) window.
You can also switch to temporarily disable/enable the software breakpoint in the S/W Breakpoint
Setting window.

1.1.1.2 Area where software breakpoint can be set

The area which can be set for software breakpoint varies depending on the product.
For the areas available for software breakpoint, see the following:
"10.1.2 Area where software breakpoint can be set"

1.2 Real-Time OS Debugging Function

This function debugs the realtime OS-dependent parts of the target program that uses the realtime
OS.
This function helps to show the status of the realtime OS.




1.3 GUI Input/Output Function

This function simulates the user target system's key input panel (buttons) and output panel on a

window.
Buttons can be used for the input panel, and labels (strings) and LEDs can be used for the output

panel.




2Preparation before Use

2.  Preparation before Use

Please run the High-performance Embedded Workshop and connect the emulator .
In addition, in order to debug with this product, it is necessary to create a workspace.

2.1 Workspaces, Projects, and Files

Just as a word processor allows you to create and modify documents, this product allows you to create
and modify workspaces.

A workspace can be thought of as a container of projects and, similarly, a project can be thought of as
a container of project files. Thus, each workspace contains one or more projects and each project

contains one or more files.

project

workspace

Workspaces allow you to group related projects together. For example, you may have an application
that needs to be built for different processors or you may be developing an application and library at
the same time. Projects can also be linked hierarchically within a workspace, which means that when
one project is built all of its "child" projects are built first.

However, workspaces on their own are not very useful, we need to add a project to a workspace and
then add files to that project before we can actually do anything.




2.2 Starting the High-performance Embedded Workshop

Activate the High-performance Embedded Workshop from [Programs] in the [Start] menu.
The [Welcome!] dialog box is displayed.

[optens
{* Create a new project workspace Ciancel |
=

=

=

{~ Cpen a recent project workspace: Adminiztration.. |
| =l

{~ Browse to another project workspace

In this dialog box, A workspace is created or displayed.
e [Create a new project workspace] radio button:
Creates a new workspace.
e [Open a recent project workspace] radio button:
Uses an existing workspace and displays the history of the opened workspace.
o [Browse to another project workspace] radio button:
Uses an existing workspace;
this radio button is used when the history of the opened workspace does not remain.

In the case of Selecting an Existing Workspace, select [Open a recent project workspace] or [Browse to
another project workspace] radio button and select the workspace file (hws).

Please refer to the following about the method to create a new workspace.

o  Refer to "2.2.1 Creating a New Workspace (Toolchain Used)"

o Refer to "2.2.2 Creating a New Workspace (Toolchain Not Used)"

* When debugging the existing load module file with this product, a workspace is created by this
method.

The method to create a new workspace depends on whether a toolchain is or is not in use. Note that
this product does not include a toolchain. Use of a toolchain is available in an environment where the
C/C++ compiler package for the CPU which you are using has been installed.

For details on this, refer to the manual attached to your C/C++ compiler package.




2Preparation before Use

2.2.1 Creating a New Workspace (Toolchain Used)

2.2.1.1 Stepl : Creation of a new workspace

In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is
activated, select the [Create a new project workspace] radio button and click the [OK] button.
Creation of a new workspace is started.

The following dialog box is displayed.

Workspace Mame:
[Ty Empty fpplication IS‘E"T‘P'ED'I
T@Impnrt Makefile o -
G Library ISampIem

Directory:

ID:¥work¥HEW4¥SampIes¥M1 GC¥Samplel] Browse... |
CPLU family:
MGG =]

Tool chain:
IF{enesaS M16C Standard LI

Properties... |

QK I Cancel

1. Select the target CPU family
In the [CPU family] combo box, select the target CPU family.
2. Select the target toolchain
In the [Tool chain] combo box, select the target toolchain name when using the toolchain.
3. Select the project type
In the [Project typel list box, select the project type to be used.
In this case, select "Application" .
(Please refer to the manual attached to your C/C++ compiler package about the details of the
project type which can be chosen.)
4. Specify the workspace name and project name
- In the [Workspace Name] edit box, enter the new workspace name.
- In the [Project Name] edit box, enter the project name. When the project name is the same as
the workspace name, it needs not be entered.
- In the [Directory] edit box, enter the directory name in which the workspace will be created.
Click the [Browse...] button to select a directory.

After a setting, click the [OK] button.




2.2.1.2 Step2 : Setting for the Toolchain

A wizard for the project creation starts.

Mew Project-1/ .t Target GPU. Toolchain

Toolchain version :
R~ |
Which CGPU do vou want to use for this
project?

CPU Series:

M16G/30
M160/20
MI6G/1D
MGG Ty [

CPU Twpe:

If there iz no GPU tvpe to be selected, zelect
the “CPU Type” that a similar to hardware
specification or select “Other”.

<Back |[ MNext> |  Finish Gancel

Here, the following contents are set.

e  toolchain

e the setting for the real-time OS (when using)

e the setting for the startup file, heap area, stack area, and so on

Please set required information and click the [Next] button.

The contents of a setting change with C/C++ compiler packages of use. Please refer to the manual
attached to your C/C++ compiler package about the details of the contents of a setting.
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2.2.1.3 Step 3: Selecting of the Target Platform

Select the target system used for your debugging (emulator, simulator).
When the setting for the toolchain has been completed, the following dialog box is displayed.

Mew Project-5/7-Setting the Tareet System for Debueeing g el |

— Targets :
WIM1GC PC4701 Emulator
[w|h16C FAC Compact Emulator
[WIMI1GC REC FalSBAUART
[wIM16C RBC PCTE0T Emulator
[wM16C R3C Simulator

—External Debugger :

Tareet type : IM'I G660 LI

Mext > | Finizh Cancel |

1. Selecting of the Target type
In the [Target typel list box, select the target CPU type.
2. Selecting of the Target Platform
In the [Targets] area, the target for the session file used when this debugger is activated must be
selected here.
Check the box against the target platform. (And choose other target as required.)

And click the [Next] button.




2.2.1.4 Step4 : Setting the Configuration File Name

Set the configuration file name for each of the all selected target.
The configuration file saves the state of High-performance Embedded Workshop except for the target
(emulator, simulator).

Mew Project tting the Debugeer Options

Target name :

7601 Emulator

Configuration name :
|Debug_M1 GG _FAC_PCTR0T_Emulator

— Detail options :

Item | Setting

e % |

<Back |[ MNext> | = Finishn |  Cancel |

The default name is already set. If it is not necessary to change, please click the [next] button as it is.
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2.2.1.5 Step5 : The check of a created file name

Finally, confirm the file name you create. The files which will be generated by the High-performance
Embedded Workshop are displayed If you want to change the file name, select and click it then enter

the new name.

Mew Project-7/7-Changine the File Names to be Created

The fallowing zource filez will be

generated:

File Ma.. | Ext. | Description
Sample0l Main Program
ncrid a30 Start up file

zectdl [31s3 Start up file

< | i

[Esct | Finizh I Cancel I

This is the end of the emulator settings.
Exit the Project Generator following the instructions on the screen.

11



2.2.2 Creating a New Workspace (Toolchain Not Used)

When debugging the existing load module file with this product, a workspace is created by this
method.(It can work even if the tool chain is not installed.)

2.2.2.1 Stepl : Creation of a new workspace

In the [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is
activated, select the [Create a new project workspace] radio button and click the [OK] button.
Creation of a new workspace is started. The following dialog box is displayed.

Tk 4701 . Workzpace Mame:
P Debueser only - MI6G PO7501 . [D05ample0T
v Debueger anly — M16G Starterk.. Froject Mame:
# Debugger only - RBG E7 SYSTEM IDOSampIeD‘I

#» Debuzeer only - RBC ES SYSTEM

Directory:

ID:¥WDrk¥HEW4¥SampIES¥M1 AC¥DOZample Browze. . |

CGPU family:
GEE =l

Tool chain:

Mone -

Properties... |

0].4 I Cancel

1. Select the target CPU family
In the [CPU family] combo box, select the target CPU family.
2. Select the target toolchain
In the [Tool chain] combo box, select "None". In this case, toolchain is not used.
(When the toolchain has not been installed, the fixed information is displayed in this combo box.)
3. Select the project type
(When the toolchain is not used, it is displayed on a [Project Typel] list box as "Debugger only -
Target Name". Select it. (When two or more project types are displayed, please select one of
them.)
4. Specify the workspace name and project name
- In the [Workspace Name] edit box, enter the new workspace name.
- In the [Project Name] edit box, enter the project name. When the project name is the same as
the workspace name, it needs not be entered.
- In the [Directoryl edit box, enter the directory name in which the workspace will be created.
Click the [Browse...] button to select a directory.

After a setting, click the [OK] button.

12
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2.2.2.2 Step 2: Selecting of the Target Platform

Select the target system used for your debugging (emulator, simulator).
A wizard starts and the following dialog box is displayed.

m for Debuegeing

— Targets :
[wIMIGC PC4707 Emulator
w165 RBC Compact Emulator
[WM16C RBC FoUSB/UART
[wIMIGC RAC PCTE0T Emulator

Tarest type : |M1 G600 ;I

Mexct | Finigh Cancel I

1. Selecting of the Target type
In the [Target typel list box, select the target CPU type.
2. Selecting of the Target Platform
In the [Targets] area, the target for the session file used when this debugger is activated must be
selected here.
Check the box against the target platform. (And choose other target as required.)

And click the [Next] button.

13



2.2.2.3 Step3 : Setting the Configuration File Name

Set the configuration file name for each of the all selected target.
The configuration file saves the state of High-performance Embedded Workshop except for the target
(emulator, simulator).

Mew Project tting the Debugeer Options

Target name :

7601 Emulator

Configuration name :
|Debug_M1 GG _FAC_PCTR0T_Emulator

— Detail options :

Item | Setting

e % |

<Back |[ MNext> | = Finishn |  Cancel |

The default name is already set. If it is not necessary to change, please click the [next] button as it is.
This is the end of the emulator settings.

Exit the Project Generator following the instructions on the screen.

And the dialog for the setup of a debugger is also displayed at this time . If preparation of an emulator
is completed, set up the debugger in this dialog box and connect with an emulator.

14
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2.2.2.4 Step4 : Registering the Load modules to be downloaded

Finally, register the load module file to be used.
Select [Debug Settings...] from the [Debug] menu to open the [Debug Settings] dialog box.

|SessionM16G_REC_PGTE0T_Emulatar | Tareet | Options |

------ I@ DoSampledl Tt
|M16C REC PCTE0T Emulator =l
Default Debug Format:
|IEEER95 RENESAS =l
Download Modules:
File Mame | Otfset Address [ Format Add..
D#work¥HEW4¥Samples¥M1 6C¥Sampled] x30 00000000 IEEEC

1 | i

Cancel |

1. Select the product name to be connected in the [Target] drop-down list box.
2. Select the format of the load module to be downloaded in the [Default Debug Format] drop-down
list box.

Format Name Contents

IEEE695_RENESAS IEEE-695 format file (When Using Renesas toolchain)
IEEE695_IAR IEEE-695 format file (When Using IAR toolchain)
IEEE695_TASKING IEEE-695 format file (When Using Tasking toolchain)
ELF/DWARF2 ELF/DWARF?2 format file (When Using Renesas toolchain)
ELF/DWARF2_TAR ELF/DWARF2 format file (When Using IAR toolchain)
ELF/DWARF2_TASKING ELF/DWARF?2 format file (When Using Tasking toolchain)
ELF/DWARF2_KPIT ELF/DWARF2 format file (When Using KPIT toolchain)

This debugger does not support the object formats, which are not shown in the drop down list.

15



3. Then register the corresponding download module in the [Download Modules] list box.
A download module can be specified in the dialog opened with a [Add...] button.

21|

Offset:  [00000000 =] ok |
Format  |IEEE695_REMESAS =] Cancel |

Filename: |D:¥HEW4¥sam|:ules¥M'lEG¥demD.x3El | 3 | Browse... |
Accezz gize: |1 vl

[~ Download debug infarmation anly

Download Module

[~ Perform memarsy verify during dovnload

[~ Download automatically on target connection

- Select the format of the download module in the [Format] edit box. Please refer to the upper
table about the format name of a download module.

- Enter the full path and filename of the download module in the [Filename] edit box.

- Specifies the access size for the current download module in the [Access size] list box.

After that, click the [OK] button.

ATTENTION
"Offset", "Access size" and "Perform memory verify during download" is ignored. The offset is always
set to 0, the access size is always set to 1 and the verification does not work.

16
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2.3 Starting the Debugger

The debugging can be started by connecting with an emulator.

2.3.1 Connecting the Emulator

Connect the emulator by simply switching the session file to one in which the setting for the emulator
use has been registered.

The session file is created by default. The session file has information about the target selected when
a project was created.

In the circled list box in the following tool bars, select the session name including the character string
of the target to connect.

Diefaults

After the session name is selected, the dialog box for setting the debugger is displayed and the
emulator will be connected.
When the dialog box is not displayed, select [Connect] from the [Debug] menu.

B U8 z(F)

2.3.2 Ending the Emulator

The emulator can be exited by using the following methods:

1. Selecting the “Disconnect”
Select [Disconnect] from the [Debug] menu.

B 108 2
2. Selecting the "DefaultSession"

Select the "DefaultSession" in the list box that was used at the time of emulator connection.

3. Exiting the High-performance Embedded Workshop
Select [Exit] from the [File] menu. High-performance Embedded Workshop will be ended.

The message box, that asks whether to save a session, will be displayed when an emulator is exited. If
necessary to save it, click the [Yes] button. If not necessary, click the [No] button.

17



3.  Setup the Debugger

3.1 Init Dialog

The Init dialog box is provided for setting the items that need to be set when the debugger starts up.
The contents set from this dialog box are also effective the next time the debugger starts. The data set
in this dialog remains effective for the next start.

Init (M16C FBG FolSE/UART?

MGU | Debugging Information | Fun Made | Script |

MCL:  MI0ZE2F3.MCLU Fefer.. |

) Parallel ) Serial g ) [P {* |USB

Monitor Debug
’7 [T | Etart up for monitor debue.

Cancel Help

[T Do not show this dialog box again.

The tabs available on this dialog box vary with each product used. For details, click the desired tab
name shown in the table below.

Tab Name Product Name
The debugger for M32C The debugger for M16C/R8C
MCU exist exist
Debugging Information exist exist
Run Mode exist exist
Script exist exist

You can open the Init dialog using either one of the following methods:
o  After the debugger gets started, select Menu - [Setup] -> [Emulator] -> [System...].
e  Start Debugger while holding down the Ctrl key.

18



3Setup the Debugger

3.1.1 MCU Tab

The specified content becomes effective when the next being start.

MG | Debugeing Information | Fur hode | Rezume |

MGL: Refer... |

(" Farallel % Serial LA = LPT " USBE
Port: |G =l

Baud Rate: | =]

Manitar Debue
’VI_ Startup for monitor debue

3.1.1.1 Specifying the MCU file

MCLE MING2E ML Refer.. |

Click the "Refer" button.

The File Selection dialog is opened. Specify the corresponding MCU file.

e An MCU file contains the information specific to the target MCU.

e  The specified MCU file is displayed in the MCU area of the MCU tab.

3.1.1.2 Setting of the Communication Interface

The displayed data varies depending on the specified communication interface.
The available communication interface varies depending on the products.
The following shows the setting for each communication interface.

Refer to "3.2 Setting of the Communication Interface"

3.1.1.3 Setting of the Monitor Debug

Monitor Debue
’7 [T Start up for monitor debue.

When you start up this debugger for the monitor debug, check the checkbox "Start up for monitor
debug". If this checkbox is checked, this debugger starts up without initializing the system (To use
this function, you need the monitor file corresponding to the monitor debug function).

19



3.1.2 Debugging Information Tab

The specified content becomes effective when the next being start.

Compiler: | J

Object Format: | J
[ On Demand
v Dizplay the instruction format specifier in
dizazzembly

= Alwavs treat variables of enumerator tvpe
with unknown zize as 1 byte.

3.1.2.1 display the compiler used and its object format

Display the compiler used and its object file format.

Compiler: | MG3IMWANGEC =]

Object Format:  [IFEE-A05 |

Please specify the compiler used and its object file format in the dialog opened by menu [Debug] ->
[Debug Settings...].

3.1.2.2 Specify the Storing of Debugging Information

There are two methods for storing debugging information: on-memory and on-demand.
Select one of these two methods. (The on-memory method is selected by default.)

To select the on-demand method, click the On Demand check box.

The specified content becomes effective when the next being download.

e  On-memory method
Debugging information is stored in the internal memory of your computer.
Usually, select this method.

e On-demand method
Debugging information is stored in a reusable temporary file on the hard disk of your computer.
Because the stored debugging information is reused, the next time you download the same load
module it can be downloaded faster.
This method is suitable when it takes so long time to download the debugging information,
because the PC has less memory against the load module file size.

Notes

e If the load module size is large, the on-memory method may be inefficient because it requires a
very large amount of time for downloading. In such a case, select the on-demand method.

e In the on-demand method, a folder in which to store a reusable temporary file is created in the
folder that contains the downloaded load module. This folder is named after the load module
name by the word "~INDEX_" to it. If the load module name is "sample.abs", for example, the
folder name is "~INDEX_sample". This folder is not deleted even after quitting the debugger.

20



3Setup the Debugger

3.1.2.3 Specify whether to display the instruction format specifier

Specify whether to display the instruction format specifier in the disassembled display.

v Display the instruction format specifier in
dizazsembly

Select the above check box when you display the instruction format specifier.
This specification can only be set or changed when you start the debugger.

3.1.2.4 To treat size of enumeration type as 1 byte

You can specify whether your debugger treat all sizes of enumeration types whose size is unknown in
the debugging information as 1 byte. For reducing memory consumption, NC30 and NC308 have an
option to treat the sizes of enumerator types as 1 byte and not as same size of 'int'. Note that NC30
and NC308 don't output the sizes of enumerator types in debugging information and debuggers
consider the size as same size of 'int'.

Therefore you may not correctly refer the values of enumeration types in the target programs which
were compiled with the above option. This function is for resolving the above issue. See the users'
manual of each compiler for details of the above option

. flmays treat variables of enumerator tvpe
with unknown zize az 1 byte

Check the above check box if you would like to treat all sizes of enumeration types as 1 byte. It is
necessary to load the debugging information again in order to reflect this setting.

21



3.1.3 Run Mode Tab

The specified content becomes effective when the next being start.

{* SamplingMode

Sampling Period
{100-5000msec) 1500 msec

{~ FreeFunMaods

3.1.3.1 Setting Run Mode

Set the mode in which you want the user program to be run when executing Go or Come. With this
debugger, the monitor program periodically monitors the user program's execution status to check
whether the user program is halted by a break, etc. This means that the monitor program interrupts
the CPU when executing the user program and, hence, the user program's real-time capability is lost.
To solve this problem, this debugger provides two execution modes:

Sampling Mode:

the user program's execution status is periodically monitored when executing Go or Come.
Therefore, it is possible to check whether the user program is halted by a break, etc. The
monitoring interval time is determined by the value you set in the Sampling period field. Set an
apporpriate interval time that will not affect execution of the user program.

Free Run Mode:

the user program's execution status is not monitored when executiong Go or Come. Therefore,
although the user program's real-time execution capability is maintained, it is impossible to
check whether the user program is halted by a break, etc. Consequently, this debugger shows
executing Go or Come status while the user program has been halted. To show the stop status,
press the STOP button.

Also, if the operations (which causes memory dump like using RAM monitor window or switching
the display mode of Source window to disassembly, and so on) are invoked while target program
is running, the real-time execution capability will be lost.
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3Setup the Debugger

3.1.4 Script Tab

The specified content becomes effective when the next being start.

Thit File: | Refer.. |

3.1.4.1 Automatically Execute the Seript Commands

To automatically execute the script command at start of Debugger, click the "Refer" button to specify
the script file to be executed.

Init File: I Refer..

By clicking the "Refer" button, the File Selection dialog is opened.

The specified script file is displayed in the "Init File:" field.

To disable auto-execution of the script command, erase a character string displayed in the "Init File:"
field.
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3.2 Setting of the Communication Interface

3.2.1 Setting of the USB Interface

USB communication uses the personal computer's USB interface. It is compliant with USB 1.1.
Before USB communication can be performed, the computer must have a dedicated device driver
installed in it.

For connection by USB communication, click the "USB" radio button on the MCU tab.

3.2.1.1 Install of USB device driver

The USB devices connected are detected by Windows' Plug & Play function. The installation wizard
for USB device drivers starts after the device had been detected. The following shows the procedure
for installing the USB device drivers.

1. Connect the host computer and the emulator with USB cable.

2. Set the emulator's communication interface switch to the "USB" position. Then turn on the power
to the emulator.

3. The dialog box shown below appears.

Found Hew Hardware

USE Device

Installing ..

Go on following the wizard, and a dialog box for specifying the setup information file (nf file) is
displayed. Specify the musbdrv.inf file stored in a location below the directory where this debugger is
installed.

ATTENTION

e Before the USB device drivers can be installed, the debugger you use must already be installed.
Install this debugger first.

e A user who install the USB device driver need administrator rights.

e During installation, a message may be output indicating that the device driver proper
musbdrv.sys cannot be found. In this case, specify the musbdrv.sys which is stored in the same
directory as is the musbdrv.inf file.
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3Setup the Debugger

3.2.1.2 Download the Monitor Program

When the monitor program, that is corresponding to the mcu that is specified by the mcu file, is
different from the one that is downloaded in the target, the debugger notices you to download it.
If the mcu file you specified is correct, download it by pressing OK buttion.

Warning

‘e should download new firmware.

d Cancel |

3.2.2 Setting of the Serial Interface

Serial communication uses a serial interface (RS-232C) of the personal computer.
This communication method is available for all the PC4701 emulator series.

3.2.2.1 Setting of the Serial Interface

To set the Serial communication, click the "Serial" radio button of the MCU tab in the Init dialog. The
setting looks like the figure below.

 Parallzl & Serial  LAM  LPT T USB
Port: IOOM'I ;I Tiareet..

Baud Rate: [25400 Xl Self Gheck

Specify the communications port in the Port field and the baud rate in the Baud Rate field.
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3.3 Setup the Debugger for M32C

3.3.1 Emem Dialog

In the Emem dialog box, setting information on the user target. The Emem dialog box opens after
closing the Init dialog box.

Emem |

Status |

Processor Mode: ISingIe-chip Mode LI

— MG Statuz

Clss MMBe  RDi% HOLD*
- -

L LP T

Cancel Help

[ Do not show this dialog box again.

The tabs available on this dialog box vary with each product used. For details, click the desired tab
name shown in the table below.

Tab Name Contents
Status Specify the processor mode.

To keep the Emem dialog box closed next time the debugger is started, check "Next Hide" at the
bottom of the Emem dialog box. You can open the Emem dialog using either one of the following
methods:

o After the debugger gets started, select Menu - [Setup] -> [Emulator] -> [Target...].
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3Setup the Debugger

3.3.1.1 Status Tab

The specified content becomes effective when the next being start.

383111  Select the Processor Mode
Specify the processor mode for the target system.

Processor Mode: aingle—chip Mode

Either the following can be specified.
e  Single-chip Mode
Single-chip Mode
e Memory Expansion
Memory Expansion Mode
e  Microprocessor
Microprocessor Mode

33112  Inspecting the MCU status
Clicking this tab displays the status of each MCU pin. It allows to check whether the MCU pin status
matches the processor mode to be set.

If the slider is at the middle position, it means that the value is indeterminate.
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4Tutorial

4, Tutonal

4.1 Introduction

This section describes the main functions of this debugger by using a tutorial program. The tutorial
programs are installed to the directory ¥WorkSpace¥Tutorial of the drive you installed
High-performance Embedded Workshop. There are workspaces for each targets and each MCUs.
Please select the corresponding one to your system, and open the workspace file (* hws) from the
menu [Open Workspace...].

The tutorial program is based on the C program that sorts ten random data items in ascending or
descending order.

The tutorial program performs the following actions:

e The tutorial function generates random data to be sorted.

e The sort function sorts the generated random data in ascending order.

e The change function then sorts the data in descending order.

Note

After recompilation, the addresses may differ from those given in this section.
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4.2 Usage

Please follow these instructions:

4.2.1 Stepl : Starting the Debugger

4.2.1.1 Preparation before Use

To run the High-performance Embedded Workshop and connect the emulator, refer to "2 Preparation
before Use".

4.2.1.2 Setup the Debugger

If it connects with an emulator, the dialog box for setting up a debugger will be displayed. Please set
up the debugger in this dialog box.

To setup the debugger in this dialog box, refer to "3 Setup the Debugger".

After the setup of a debugger, it will function as a debugger.
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4Tutorial

4.2.2 Step2 : Checking the Operation of RAM

Check that RAM is operating correctly. Display and edit the contents of the memory in the [Memory]
window to check that the memory is operating correctly.

Note

The memory can be installed on the board in some microcomputers. In this case, however, the above
way of checking the operation of memory may be inadequate. It is recommended that a program for
checking the memory be created.

4.2.2.1 Checking the Operation of RAM

Select [Memory] from the [CPU] submenu of the [View] menu and enter the RAM address (Here,
enter “400”) in the [Display Address] edit boxes. The [Scroll Start Address] and [Scroll End Address]
editing box is left to a default setting. (By default, the scroll range is set to Oh to the maximum
address of MCU.)

Display Address : ﬂﬂ
Digplay Address: Im vI
Scroll Start Address: IUUUUDD LI
Scroll End Address:  [OFFFFF =]

oK I Cancel |

Note

The settings of the RAM area differ depending on the product. For details, refer to the hardware
manual.
Click the [OK] button. The [Memory] window is displayed and shows the specified memory area.

< Memory [000400] B ] [
vz DB 2 BB £ a2 | B

fddress | Label | Rezister | +0 +1 +2 +3 +4 +5 +6 47 +8 +§ +h +B 40 +D +E +F | ASCII Iﬂ
000400 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 .........
000410 DF D& F& OF 20 0& 00 OO 20 04 OO0 00 00 03 00 00 .... ...
000420 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .........
000430 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .....uuus
000440 FF FF[ZH)FF FF FF FF FF FF FF FF FF FF FF FF FF ..H......
000460 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .....uu..
000480 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .....uu..
000470 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

00n4an FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

000440 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

000440 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

0004E0 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .

0004co FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF .

000400 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

2|

Placing the mouse cursor on a point in the display of data in the [Memory]l window and
double-clicking allows the values at that point to be changed.
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4.2.3 Step3 : Downloading the Tutorial Program

4.2.3.1 Downloading the Tutorial Program

Download the object program to be debugged. The download file and the address to be downloaded
will depends on the target mcu you uses. Please replace the screen image and addresses with
corresponding one to your target mcu.
e The Debugger for M16C/R8C or M32C

Select [Download module] from [Tutorial.x30] under [Download modules].

E@ Tutorial

EI@ Tutorial

=3 Azsembly zource file

nicril.a30
-3 C souree file
zortc
Tutorialc
=3 Download modules

1

=3 Dependencic :
e defin Download (Debug Data Only)

zectI0.i Urlaad
zarth

Download & MNew Module..
Bemove

Debug Settings..

Configure Wiem..

IT Bllow Dockine
Hide

FProperties...
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4Tutorial

4.2.3.2 Displaying the Source Program

This debugger allows the user to debug a user program at the source level.
Double-click [tutorial.c] under [C source file]l. A [Editor(Source)] window opens and the contents of a
"Tutorial.c" file are displayed.

E@ Tutorial ||
=-[E Tutorial .
Ea fzsembly source fils Line Sour.. | 5. Source
Lo ncrt0.asl 13
Ea G source fils }g ;ﬁ?ﬁc?[égﬂi, le =t:
sort.c 18 F ’
Tutorialc 17 void mainivoid)
Ea Diownload modules 18 |FA4214 i .
- Tutarialx30 - OOOOO000 19 |F4214 while (1){
£-£3 Dependencies 20 [F421E tutarial);
i IEE 21 |Fd221 !
ne_define.inc 29 |F4n2g 1
: gectiling 23
. sorth 24 void tuterialivoid)
25 [(F4224 i
25 lomg J:
27 int i;
28 ztruct Zample far #p_sam:
24
30 [F4227 p_sam= kst
31 [F4231 init{p_sam);
3z
33 |F423D far( i=0: §i<10; i++ 3
<] |
e [Br [ [Bre] || & Turaic |

Select the [Format Views...] option from the [Setup] menu to set a font and size that are legible, if
necessary.

Initially the [Editor(Source)] window shows the start of the user program, but the user can use the
scroll bar to scroll through the user program and look at the other statements.

35



4.2.4 Step4 : Setting a Breakpoint

A software breakpoint is a basic debugging function.
The [Editor(Source)] window provides a very simple way of setting a software breakpoint at any point
in a program.

4.2.4.1 Setting a Software Breakpoint

For example, to set a software breakpoint at the sort function call:
Double-click the [S/W breakpoints] column on the line containing the sort function call.

« Tutorial.c i ; d =10l x|
= &l
Line Sour.. | S Source |

a1 |[F4231 init{p_sam);

a2 j

33 |F423D forf i=0: P10 i++ )

34 (F4248 i = randi();

ah |Fd42h4 ifii < 031

36 |F4254 = -i:

a7 h

a8 |F42B2 alil = J:

34 !

a0 |(F4276 | 4 sortial;

41 |F427E changelal;

42

43 |F4286 p_zam-rsl=a[0];

44 |F42498 F_sam-»s1=a[1]:

4h |F42AE p_sam-rz2=al2];

48 |F42CE p_san->si=a[3]; bl
< | AW

The red symbol will appear on the line containing the sort function call. This shows that a
softwarebreak breakpoint has been set.
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4Tutorial

4.2.5 Stepb : Executing the Program

Execute the program as described in the following:

4.2.5.1 Resetting of CPU

To reset the CPU, select [Reset CPU] from the [Debug] menu, or click the [Reset CPU] button T
on the toolbar.

4.2.5.2 Executing the Program

To execute the program, select [Go] from the [Debug] menu, or click the [Gol button on the

toolbar.
The program will be executed up to the breakpoint that has been set, and an arrow will be displayed
in the [S/W Breakpoints] column to show the position that the program has halted.

< Tutorial.c A ; ;IEIEI
Bl
Line Sour.. | 5. Source |

31 |F42d1 init{p_zam);

a2 g

33 |Fa2iD farf i=0; i<10:; i++ )

34 |F4248 i = randi};

a5 |F42h4 ifCi <0

36 |F4253 i=-i:

a7 1

a8 |F42E2 alil = i:

a4 1

40 |F4276 | & sort{a);

41 |F427E changelal;

42

43 |F4288 p_zam-rsl=a[0]:

44 |F4298 p_zam-»zl1=a[1];

45 |F424E p_sam-rsi=al2];

4F |F42CE p_sam->zi=a[3]; bl
4| | 4

Note

When the source file is displayed after a break, a path of the source file may be inquired. In this case,
please specify the location of a source file.
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4.2.5.3 Reviewing Cause of the Break

The break factor is displayed in the [Output] window.

Hoiora ar|2igt|o|m=d|?

Connected
Causze of break: 3/W break

1A I :I;. Build }-.Debug ;'{ Find iin Files }H. Mzcro }-.. Tast }H. Version Control f

The user can also see the cause of the break that occurred last time in the [Status] window.

Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is displayed,
open the [Platform] sheet, and check the Status of Cause of last break.

- Statuz

Item | Status |
Connected to MiaC RSC PCY501 Emulator

CPU Miac

Fun Ztatus Feady

Cause of last break 3/ hreak

Fun time count 00 h 00 w OO0 sec 001 mwmsec 991 usec

A B 1% Memoary A Platform f{. Ewents j‘

Please refer to "9 Display the Cause of the Program Stoppage" about the notation of a break factor.

38



4Tutorial

4.2.6 Stepb6 : Reviewing Breakpoints

The user can see all the breakpoints set in the program in the [Breakpoints] dialog box.

4.2.6.1 Reviewing Breakpoints
Push the key Ctrl+B, and the [Breakpoints] dialog box will be displayed.

Breakpoints

Cancel |
Edit Gode |
Bemowve |
Femowve Al |

This window allows the user to delete, enable, or disable breakpoints.
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4.2.7 Step7 : Viewing Register

The user can see all registers/flags value in the [Register] window.

4.2.7.1 Viewing Register

Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is displayed.
The figure below shows a Register window of the debugger for M16C/R8C.

0 BANK — Reeister 5 |

HN... Walue R..

RO ooz4 Hex
Rl aFao Hex
R Qoo Hex
B3 Qoo Hex
AD OEEE Hex
Al aooo Hex
FE o7ria Hex
U3p  06/CZ Hex
ISP DAZ0 Hex
=l OFO0Z6F Hex
3B o400 Hex
INTE OFFDO0 Hex

ren| u| 1] o] 8| = 2| 2 <]
010000101

4.2.7.2 Setting the Register Value

You can change a register/flag value from this window.
Double-click the register line to be changed. The dialog is opened. Enter the value to be changed.

PG - Set Value x|

Radix :  |Hex =
et A I'l.l'l.l'hl:l|E Fegizter ll

(0] 8 I Cancel |
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4Tutorial

4.2.8 Step8 : Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been

registered in the [ASM Watch] window.

4.2.8.1 Viewing Memory

For example, to view the memory contents corresponding to __msize in word size:

Select [ASM Watch] from the [Symbol] submenu of the [View] menu, open the [ASM Watch] window.
And click the [ASM Watch] window with the right-hand mouse button and select [Add...] from the
popup menu, enter __msize in the [Address] edit box, and set Word in the [Size] combo box.

fddress: |_msize| ;l

Size: I'I.I'I.I'u:uru:l ;I

Radix: ¢ Hex  Dec & Bin

0] 4 I Cancel

2]

Click the [OK] button. The [ASM Watch] window showing the specified area of memory is displayed.

o ASMWatch

oeme X K| 7 2 0 6|8

=10l x|

Address:Eit I Expression | Zize | Radix I Data

ooog1c _ m=ize Word Hex Q300
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4.2.9 Step9 : Watching Variables

As the user steps through a program, it is possible to watch that the values of variables used in the
user program are changed.

4.2.9.1 Watching Variables

For example, set a watch on the long-type array a declared at the beginning of the program, by using
the following procedure:

Click the left of displayed array a in the [Editor(Source)] window to position the cursor, and select
[Add C Watch...] with the right-hand mouse button. The [Watch] tab of [C watch] window in which
the variable is displayed opens.

=S AR P = N

Watch | Local | File Local | Global |
Hame | Value | Address | Scope |
+({=zigned long [10]) a Q00414 [Bmato]

The user can click mark '+ at the left side of array a in the [C Watch] window to watch all the
elements.

X B2 E 2w |@ ]S |
Watch | Local | File Local | Global |
Hame |value |Address |Scupe |
-{=2zigned long [10]) a Q00414 [Bmato]

(signed long)} (a) [0] 16E3E 200414

(signed long)} (a)[1] 5738 000418

(zigned long) (a) [2] 10113 20041cC

{zigned long)} (a) [3] 17515 Q00420

(signed long} (a) [4] 31051 200424

(signed long) (a)[3] 5627 Q00428

(zigned long) (a) [6] 23010 20042C

{zigned long} (a) [7] 7419 Q00430

(signed long) (a) [8] 1le2lZ2 200434

(signed long) (a) [9] 40Ee 000438
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4Tutorial

4.2.9.2 Registering Variable

The user can also add a variable to the [C Watch] window by specifying its name.

Click the [C Watch] window with the right-hand mouse button and select [Add...] from the popup
menu.

The following dialog box will be displayed. Enter variable i.

Add new watch point

Cancel |

Click the [OK] button. The [C Watch] window will now also show the int-type variable i.

X R4 6 2| @S

Watch | Local | File Local | Global |

Name | Value | Address | Scope |
+(signed long [10]) a 200414 [Zuto]
(signed int) i 10 Q00R62 [Buto]
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4.2.10 Step10 : Stepping Through a Program

This debugger provides a range of step menu commands that allow efficient program debugging.

1. StepIn
Executes each statement, including statements within functions(subroutines).
2. Step Out

Steps out of a function(subroutine), and stops at the statement following the statement in the
program that called the function(subroutine).

3. Step Over
Executes a function(subroutine) call in a single step.
4. Step...

Steps the specified times repeatedly at a specified rate.

4.2.10.1 Executing [Step In] Command

The [Step In] command steps into the called function(subroutine) and stops at the first statement of

the called function(subroutine).

To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step In] button
&

on the toolbar.

The PC cursor moves to the first statement of the sort function in the [Editor(Source)] window.

=10l x|

= &lel
Line Sour.. | 5. Source |

18 [F40B7 p_zam-x=s7 = 0; j

19 |F40CF p_zam-»sd = [; -

20 |(F40ET p_sam-»sd = 0;

21 |F40FF h

22

23 sort(lonz #a)

24 [F4102 | (]

2h long 1

25 int i, J. k., zap:

27

28 |Fatns gap = b;

23 |F410B whilel gap » 0 7

a0 |F4114 for{ k=03 kigap: k++){

31 (Fa1zi forf isktzgap; i<10; i=itgap 1{

22 |F4131 for{izi-zap: j»<k: j=i-zap){

33 |Fat14n iflalilrali+zap] id

34 Fa161 tfﬂa[_i]:r . -
*| | 4
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4Tutorial

4.2.10.2 Executing [Step Out] Command

The [Step Out] command steps out of the called function(subroutine) and stops at the next statement

of the calling statement in the main function.

To step out of the sort function, select [Step Out] from the [Debug] menu, or click the [Step Outl

{"'l

button on the toolbar.

The PC cursor slips out of a sort function, and moves to the position before a change function.

<& Tutorial.c

=10 x|

Line Sour.. | 5. Source
219
a0 |Fazz27 F_zam= kst
31 |F4231 init{p_sam):
az
33 |F423D faorf i=0; i1<10;
34 |(F4243 i = rand():
35 |F42h4 ifi) < oy
36 [F42517 I =-i;
ar
a8 |(F42g? alil = i;
a1 !
40 |(FA276 | i sart(a):
41 [F427E| 2| chanzelal;
42
43 |F4288 p_zam-»=s0=al0];
44 |F423% p_zam-rsi=all];
45 |F42AE p_zam-rsi-a [2] :
1] |

i++

Note

It takes time to execute this function. When the calling source is clarified, use [Go To Cursor].
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4.2.10.3 Executing [Step Over] Command

The [Step Over] command executes a function(subroutine) call as a single step and stops at the next
statement of the main program.
To step through all statements in the change function at a single step, select [Step Over] from the

i
[Debugl] menu, or click the [Step Over] button b on the toolbar.
The PC cursor moves to the next position of a change function.

«# Tutorial.c : i -10| x|
[E¥=ll=]
Line Sour.. | 5. Source |

24

a0 |F4227 p_zam= kst j

31 |Fd4231 init{p_zam);

a2

33 |F423D fart i=0; i<10: i++ 31

34 |F4244 i = rand(};

a6 |F4254 ity <0

36 |F4254 i=-i:

ay h

a8 |F42g2 alil = i;

a4 1

A0 |FA276 | i sort(a);

41 |F427E chanzela);

42

43 (F4286 | | p_zam-»s0=a[0]:

44 |F4234 p_zam-rsl=all]:

45 |Fazae p_san->s2zal2] .
< | M 4
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4Tutorial

4.2.11 Step11 : Forced Breaking of Program Executions

This debugger can force a break in the execution of a program.

4.2.11.1 Forced Breaking of Program Executions

Cancel all breaks.
To execute the remaining sections of the main function, select [Gol from the [Debugl menu or the [Go]

button on the toolbar.
The program goes into an endless loop. To force a break in execution, select [Halt Program] from the

di

[Debugl menu or the [Halt] button on the toolbar.
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4.2.12 Step12 : Displaying Local Variables

The user can display local variables in a function using the [C Watch] window.

4.2.12.1 Displaying Local Variables

For example, we will examine the local variables in the tutorial function, which declares three local
variables: 1, j, and p_sam.

Select [C Watch] from the [Symbol] submenu of the [View] menu. The [C Watch] window is displayed.
By default, [C watch] window has four tabs as following:

[Watch] tab

Only the variable which the user registered is displayed.

[Local] tab

All the local variables that can be referred to by the scope in which the the PC exists are
displayed. If a scope is changed by program execution, the contents of the [Local] tab will also
change.

[File Locall tab

All the file local variables of the file scope in which the PC exists are displayed. If a file scope is
changed by program execution, the contents of the [File Locall tab will also change.

[Global] tab

All the global variables currently used by the downloaded program are displayed.

Please choose the [Local] tab, when you display a local variable.

=D |

Watch Local | File Local | Global |

Hame Value Bddress |
{zigned imt) i 10 Q00RG2
{zigned long) 26824 000R5R

+{struct Sample *) p sam Ox43C Q00RASE

Double-click the mark '+ at the left side of pointer p_sam in the [Locals] window to display the

structure *(p_sam).
When the user refers to the members of the structure at the end of the Tutorial function, it is clarified

that random data is sorted in descending order.
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4.2.13 Step13 : Stack Trace Function

The debugger uses the information on the stack to display the names of functions in the sequence of
calls that led to the function to which the program counter is currently pointing.

4.2.13.1 Reference the function call status

Double-click the [S/W Breakpoints] column in the sort function and set a software breakpoint.

=10l x|

IEfsli=
Line Jour.. | 5. Source |

22

23 sort(long #a) g

24 |Fa102 {

25 long t;

26 int i, J. k. zap;

27

28 |F410%8 gap = b:

29 |F410B whilef gap > 0 3

a0 (F4114 forf k=07 k<gap; k++){

31 (F4121 fort i=kt+gap: (<107 i=itzap )

22 [F4131 for(izi-gap: j2=k: j=i-gap){

33 (F4140 | i ifitalil=alitzap]lii

34 |F4161 | t o= alil;

35 |F4170 alil = ali+zap]:

36 [F4181 alitzap] = t;

a7 !

aa elze -
1| | M 4

To executes the user program from the reset vector address, select [Reset Gol from the [Debugl] menu,

or click the [Reset Go] button on the toolbar.
After the break in program execution, select [Stack Trace] from the [Code] submenu of the [View]
menu to open the [Stack Trace] window.

StackTrace

K:‘Lnd| Mame | Value |
F sort { 0r4140 ]

F tutorial { 0F4276

F main { OF4Z21E

The upper figure shows that the position of the program counter is currently at the selected line of the
sort() function, and that the sort() function is called from the tutorial() function.
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4.2.14 What Next?

This tutorial has described the usage of this debugger.

Sophisticated debugging can be carried out by using the emulation functions that the emulator offers.
This provides for effective investigation of hardware and software problems by accurately isolating
and identifying the conditions under which such problems arise.
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5Windows/Dialogs

5. Windows/Dialogs

The window of this debugger is shown below.

When the window name is clicked, the reference is displayed.

Window Name View Menu

RAM Monitor Window [View]->[CPU]->[RamMonitor]

ASM Watch Window [View]->[Symbol]->[ASMWatch]

C Watch Window [View]->[Symbol]->[CWatch]

Script Window [View]->[Script]

S/W Break Point Setting Window [View]->[Break]->[S/W Break Points]
GUI I/O Window [View]->[Graphic]->[GUI 1/0O]

MR Window [View]->[RTOS]->[MR]

For the reference of the following windows, refer to the help attached to a High-performance

Embedded Workshop main part.

e Differences Window
e  Map Window

¢ Command Line Window
e  Workspace Window

e  Output Window

e Disassembly Window
e  Memory Window

e IO Window

e  Status Window

e  Register Window

e Image Window

e  Waveform Window

e Stack Trace Window
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5.1 RAM Monitor Window

The RAM monitor window is a window in which changes of memory contents are displayed while
running the target program.
The displayed contents are updated at given intervals while running the target program.

| 1ol x|
’Tllllll::::’l__ﬁmimﬁZ”E&Eﬂi&.t.d.lsm“ﬁ
Address | || Label || Rezister Hl 41 42 +5 +4 45 4B 47 4B #9 +A 4B +C 4D +E +F| IT | -
an400 |_poal [3E] a0 oo o0 00 00 Q0 00 00 00 00 00 00 00 00 00 00 fe.ooeeeieioaa..s
an41o 42 00 00 00 00 00 00 00 00 00 41 04 00 00 41 04 PP T
0420 anooo o003 00 00 41 4 44 43 44 45 4B 47 48 44 ABDCDEFGHI
an43n 44 0A B4 BE BA T3 20 OB TR 20 T4 BR TR T4 2E 0
a0440 a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo
00450 a0 oo oo oo 00 0D 00 0D 00 00 00 oo Qo oo oo oo
00460 oo o0 o0 oo oo o0 oo oo MO o0 00 00 00 00 00 oo
_0no4yo a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo
_ono4en || a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo
_ono4s0 | | a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo
_0nodan a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo
000480 a0 oo oo oo 00 0D 00 0D 00 00 00 o0 Qo oo oo oo LI
Address Lahel Register Data Code

e This system provides a 1Kbytes of RAM monitor area, which can be placed at any continuous
addresses.

e The RAM monitor area can be changed to any desired address range.
Refer to "5.1.2 Setting the RAM monitor area" for details on how to change the RAM monitor area.
The default RAM monitor area is mapped into a 1-Kbyte area beginning with the start address of
the internal RAM.

e The display content updating interval can be set for each window individually.
The actual updating interval at which the display contents are actually updated while running
the target program is shown in the title field of the Address display area.

ATTENTION

e The interval time at which intervals the display is updated may be longer than the specified
interval depending on the operating condition (shown below).
- Host machine performance/load condition
- Communication interface
- Window size (memory display range) or the number of windows displayed
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5Windows/Dialogs

5.1.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function
RAM Monitor Area... Set RAM monitor base address.
Sampling Period... Set RAM monitor sampling period.
Clear Clear access attribute.
Up Moves display position to the immediately preceding
RAM monitor area (smaller address)
Down Moves display position to the immediately following
RAM monitor area (larger address)
Address... Display from specified address.
Scroll Area... Specify scroll range.
Data Length 1byte Display in 1Byte unit.
2bytes Display in 2Byte unit.
4bytes Display in 4Byte unit.
8bytes Display in 8Byte unit.
Radix Hex Display in Hexadecimal.
Dec Display in Decimal.
Single Dec Display in Signed Decimal.
Oct Display in Octdecimal.
Bin Display in Binary.
Code ASCII Display as ASCII character.
SJIS Display as SJIS character.
JIS Display as JIS character.
UNICODE Display as UNICODE character.
EUC Display as EUC character.
Float Display as Floating-point.
Double Display as Double Floating-point.
Layout Label Switch display or non-display of Label area.
Register Switch display or non-display of Register area.
Code Switch display or non-display of Code area.
Column... Set the number of columns displayed on one line.
Split Split window.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5.1.2 Setting the RAM monitor area

Choose the popup menu [RAM Monitor Area...] in the RAM monitor window.

The Set RRAM Area dialog box shown below will appear.

The start address of the currently set RAM monitor area and the range of the RAM monitor area are
displayed in the Start and the Area fields of this dialog box. (No values can be entered in the Size
field.)

Set RRAM Area

Start: [310 ~

Size 1 = blocks

fres: 0002710 - DOOCOF

Cancel |

Use this dialog box to change the position of the RAM monitor area.
o  Specify the RAM monitor area by its start address. The size cannot be changed (fixed to 1 Kbyte).
e The start address can be specified in 0x10 byte units.
If you specify a non-aligned address value, it is rounded off to the nearest address value in 0x10
byte units before being set.

5.1.2.1 Changing the RAM Monitor Area

The start address of the RAM monitor area can be changed.
Specify the start address of the RAM monitor area in the Start field of the Set RRAM Area dialog box.
(No values can be entered in the Size field.)
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5Windows/Dialogs

5.2 ASM Watch Window

The ASM watch window is a window in which you can register specific addresses as watchpoints and
inspect memory contents at those addresses.

Toolbar
=] 3

e X B4 oz 0] |&

dddressiBit Expression Size Fadix [ata |

ngoonn __RUnt =l Bute Hex n4

080655 _Buf Taki+1 Byte Hex n4

084620 __[bg_cnt Bute Hex n4

0108CB:4 _Dbz_mode? Byte Bit 1

Addrezs/Bit No. Data Length T Dats
Expression Fadix

e The addresses to be registered are called the "watchpoints." One of the following can be
registered:
- Address (can be specified using a symbol)
- Address + Bit number
- Bit symbol

e The registered watchpoints are saved in the debugger when the ASM watch window is closed and
are automatically registered when the window is reopened.

e If symbols or bit symbols are specified for the watchpoints, the watchpoint addresses are
recalculated when downloading the target program.

e The invalid watchpoints are marked by "-<not active>-" when displayed on the screen.

e The order in which the watchpoints are listed can be changed by a drag-and-drop operation.

e The watchpoint expressions, sizes, radixes and datas can be changed by in-place editing.
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5.2.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function
Add... Add watchpoint.
Add Bit... Add bit-lebel watchpoint.
Remove Remove the selected watchpoint.
Remove All Remove all watchpoints.
Set... Set new data to selected watchpoint.
Radix Bin Display in Binary.
Dec Display in Decimal.
Hex Display in Hexadecimal.
Refresh Refresh memory data.
Layout Address Area Switch display or non-display of Address area.
Size Area Switch display or non-display of Size area.
RAM Monitor Enable RAM Monitor Switch enable or disable RAM moniter function.

Sampling Period...

Set RAM monitor sampling period.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5Windows/Dialogs

5.3 C Watch Window

The C Watch Window displays C/C++ expressions and their values (results of calculations).
The C/C++ expressions displayed in the C Watch Window are known as C watchpoints. The displays
of the results of calculating the C watchpoints are updated each time a command is executed.

Chifatch Ei |
X K P E 2o |F B e |
'I.I'l.l'atu:hl Local I File Local Glabal |
Narne | Value Address |;
- [struct tag = *) ps Ox1 ooo41iao

+istruct tag = | *(ps) Qoooo1
(signed short) global short 0 ooo41z
(gigned long] global long -1 ooo414
—-(=zigned int [3][3]) global array 15 ooo41a
—(zigned int [D]} [(global array) [0] 15 ooo41a
(zigned int) [(global array) [0])[0] 15 ooo41a
(signed int) [(global array) [0])[1] Z649 oo041a
(2igned int) [(global array)[0])[2] O ooo41c |
(zigned int) [(global array) [0])[3] 2645 OO041E
(zigned int) [(gleobal array)[0])[4] O ooo4z0
+(zigned int [3]) (global array) [1] TE8 ooo4zz
+({signed int [51) (global array)[2] 31843 ooo4zc [

e  Variables can be inspected by scope (ocal, file local or global).
e The display is automatically updated at the same time the PC value changes.
e Variable values can be changed.
e The display radix can be changed for each variable individually.
- The initial display radix can be changed.
- Leading-zero suppression is selectable in hexadecimal display.
e Any variable can be registered to the Watch tab, so that it will be displayed at all times:
- The registered content is saved for each project separately.
- If two or more of the C watch window are opened at the same time, the registered.
- The reference scope of the variable is selectable from current scope, global scope and each file's
scopes.
e The C watchpoints can be registered to separate destinations by adding Watch tabs.
e  Variables can be registered from another window or editor by a drag-and-drop operation.
e The C watchpoints can be sorted by name or by address.
e The RAM monitor can be allocated to the address of specified variable
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ATTENTION

e  You cannot change the values of the C watch points listed below:
- Register variables
- C watch point which does not indicate an address(invalid C watch point)

e If a C/C++ language expression cannot be calculated correctly (for example, when a C/C++ symbol
has not been defined), it is registered as invalid C watch point.
It is displayed as "--<not active>--". If that C/C++ language expression can be calculated correctly
at the second time, it becomes an effective C watch point.

e The display settings of the Local, File Local and Global tabs are not saved. The contents of the
Watch tab and those of newly added tabs are saved.

e The RAM monitor function of this debugger is realized with memory dump. Real-time capability
is impaired when this function is used.

e The background color by the access attribute cannot be changed.

About more information for C variables, please refer to "10.1.3 Get or set C variables"
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5Windows/Dialogs

5.3.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function

Add... Add C watchpoint.

Remove Remove the selected C watchpoint.
Remove All Remove all C watchpoints.

Initialize Reevaluates the selected C watchpoint.

Set New Value...

Set new data to selected C watchpoint.

Radix

Hex Display in Hexadecimal.
Bin Display in Binary.
Default Display in Default Radix.
Toggle(All Variables) Change radix (toggle).

Set initial...

Set initial radix.

Refresh

Refresh memory data.

Hide type name

Hide type names from variables.

Show char* as string

Selects whether to display char* type as a string.

Zero suppress in Hex display

Suppress zero in Hex display.

Sort Sort by Name Sort variables by its name.
Sort by Address Sort variables by its address.

RAM Monitor Enable RAM Monitor Switch enable or disable RAM monitor function.
Sampling Period... Set RAM monitor sampling period.
Arrange a RAM monitor | Arrange a RAM monitor area around this variable.
area around this variable
Start Recording... Start to record the updated values.
Stop Recording Stop recording the updated values.

Add New Tab... Add new tab.

Remove Tab

Remove the selected tab.

Copy

Copy the selected item to the clipboard.

Copy All

Copy the all items in the sheet to the clipboard.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5.4 Script Window

The Script Window displays the execution of text -format script commands and the results of that
execution.

Script commands can be executed using a script file or interactively. You can also write script
commands in the script file so that they are automatically executed. The results of script command
execution can also be stored in a previously specified log file.

Toolbar

PPEEEREHE N

Script: Script File Name Loe: Log File Mame

razzemble _main
WODRESS>  LABEL FROGRAK
OF0042  _main:
>

Execution Result Ares

K1 ||

assenble _main ;l
Command History Area

4] | b

Enter Cammand: Command Input Area

e  The Script Window has a view buffer that stores the results of executing the last 1000 lines. The
results of execution can therefore be stored in a file (view file) without specifying a log file.

e  When a script file is opened, the command history area changes to become the script file display
area and displays the contents of the script file. When script files are nested, the contents of the
last opened script file are displayed. The script file display area shows the line currently being
executed in inverse vide.

e When a script file is open, you can invoke script commands from the command input area
provided the script file is not being executed.

e  The Script Window can record the history of the executed commands to a file. This function is not
the same as the log function. This function records not the result but only the executed
commands, so the saved files can be used as the script files.
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5Windows/Dialogs

5.4.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function
Script Open... Open script file.
Run Run script file.
Step One step execution of script file.
Close Close script file.
View Save... Save view buffer to file.
Clear Clear view buffer.
Log On... Open log file and start recording (start output to file).
Off Close log file and end recording (stop output to file).
Record On... Record the executed commands to a file.
Off Stop recording the executed commands.
Copy Copy the selection and put it on the Clipboard.
Paste Insert Clipboard contents.
Cut Cut the selection and put it on the Clipboard.
Delete Erase the selection.
Undo Undo the last action.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5.5 S/W Break Point Setting Window

The S/W Break Point Setting window allows you to set software break points.
Software breaks stop the execution of instructions immediately before the specified break point.

Save/Load Break Point Buttons
Set Break Point Area

B C.W Break Foints
load. | Save. | |

% Address: |

= Filename: [

Close

Line: [

S/W Break Point:

0F0000

Display Break Points

OF0oC2 [ 36] GLOBAL.C
OF012C [ 22] LOCAL.C

Delete All

All Enable

All Disable

1

Operation Buttons to Break Points

e If you have set multiple software breakpoints, program execution stops when any one software

break address is encountered (OR conditions).

e You can continue to set software breakpoints until you click the "Close" button to close the S/'W

Break Point Setting Window.

e You can clear, enable or disable software breakpoints selected by clicking in the software

breakpoint display area. You can also enable and disable software breakpoints by double-clicking

on them.

e  C(Click on the "Save" button to save the software break points in the file. To reload software break
point settings from the saved file, click the "Load" button. If you load software break points from
a file, they are added to any existing break points.
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5Windows/Dialogs

5.5.1 Command Button

The buttons on this window has the following meanings.

Button Function

Load... Load setting information from a file in which it was saved.
Save... Save the contents set in the window to a file.

Help Display the help of this window.

Add Add the break point.

Refer... Open file selection dialog box.

Close Close the window.

Delete Remove the selected break point.

Delete All Remove all break points.

Enable Enable the selected break points.

All Enable Enable all break points.

Disable Disable the selected break point.

All Disable Disable all break points.

View Shows the selected breakpoint positions in the Editor(Source) window.
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5.5.2 Setting and Deleting a Break Points from Editor(Source) Window

The area which can be set in the software breakpoint is different according to the product. Please
refer to "10.1.2 Area where software breakpoint can be set" for details.

You can set break points in the Editor(Source) Window. To do so, double-click the break point setting
area ("S/W breakpoints" column) for the line in which you want to set the break. (A red marker is
displayed on the line to which the break point was set.)

. Sample.c

40 | fO03a i=0; j

41 | fooad while(1) {

42 | fo041 for €0 = 0 0 < DATA_SIZE & i++) {

43 | fO04c datali]+:

44 | f005¢c || data[i+1]+;

45 | fO0ES data[i+2]++; J

48 | f0075 data[i+3]++;

a7 N }

48 | fO087 subl);

45 | f008a

B0 | fO0Bc 1

b1

i -
KAl M

Douhle click

You can delete the break point by double-clicking again in the break point setting area ("S/W
breakpoints" column).

In the Editor(Source) window, a display of "S/W breakpoints" column is set to "Enable" by default. To
erase this column, deselect the [S/W breakpoints] check box in the dialog box opened by choosing the
main menu - [Edit] > [Define Column Format]. The "S/W breakpoints" column is erased from all
Editor (Source) windows. And select popup menu - [Columns] -> [S/W breakpoints] in the Editor
(Source) window, A column can be set up for each Editor (Source) windows.
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5Windows/Dialogs

5.6 GUI I/0 Window

The GUI I/O window allows you for port input by creating a user target system key input panel
(button) in the window and clicking the created button. And this window also allows you to implement
the user target system output panel in the window.

- GUI 10 - Samplepnl

rx|AEa8 S ®

7 i o
4 a i
1 z 3

0 .

Irput Parel

. | o

e  You can arrange the following parts on the window.
- Label (character string)
Displays/erases a character string specified by the user when any value is written to the
specified address (bit).
- LED
Changes the display color of any area when any value is written to the specified address (bit).
(Substitution for LED ON)
- Button
A virtual port input can be executed at the time the button is pressed.
- Text
Display the text string.
e  You can also save the created panel in a file and reload it.
e You can set up to 200 address points to the created part. If different addresses are set to the
individual parts, you can arrange up to 200 parts.
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5.6.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function

Select Item Select an I/0 item.

Delete Delete the selected I/0O item.
Copy Copy the selected I/O item.
Paste Paste the copied I/0 item.

Create Button

Create a new button item.

Create Label

Create a new label item.

Create LED

Create a new LED item.

Create Text

Create a new text item.

Display grid

Display the grid line.

Save...

Save 1/0 panel file.

Load...

Load I/0 panel file.

Sampling Period...

Set RAM monitor sampling period.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5.7 MR Window

Use the MR Window to display the status of the realtime OS.

You can only use the MR Window when you have downloaded a program that uses the realtime OS Gf
the downloaded program does not use the MR, nothing is displayed in the MR Window when it is
opened.)

MR =]
BWiOP=HUuOTHL - HFEE
Gurrent Run Task:[1] Cmain)
ID | Stadddr | [name| | Pri| atatus | Wup count Gimeout | flg ptn | flg mode ﬂ
1 OF17F8H  (_main) 1 FRUN 00o0o0H
Z OF1A68H (_taski) Z RDY 00o00H
3 OF1ATEH [_task3) i gus 00o0o0H
4 OF1AB4H [_taskd) 1 WAI(SLP} 00o0o0H
5 OF1ADAH | _task5) 1 WAI(SLP}-3US3 0000
6 OF1ABOH (_taske) 1 WAI(DLY) 00o0o0H TFFFH
7 OF1ACAH [ task7) 1 WAI(DLY) -SUS 0000H 7FFFH
4 OF1AE4H [ _taskd) 1 WAI(FLG) oooog --——- 1111H TWF_ ORI
J_gl OF1EO0ZH | taskd) 1 WAI(FLG)-3US oooog o ————e 1111H THF OFRW _ILI
4 4

e You can open the MR window as many as the number of display modes .

e By clicking the desired button, the MR window display mode changes and the display data also
changes.

e By double-clicking the desired task line, you can display the context data of the task.

e  You can drag the cursor to change the width of the display area in each mode.

e If the downloaded program does not use MR, you cannot select all the menu which will select the
display mode.

e The usable display mode depends on MRxx.

ATTENTION

Please use the startup file (crtOmr.axx/start.axx) whose contents matches with the version of MRxx,
when you make downloaded program. The MR Window and MR command will not run properly if the
startup file you uses don't match with the version of MRxx.
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5.7.1.1 Extended Menus

This window has the following popup menus that can be brought up by right-clicking in the window.

Menu Function
Mode Task Displays Task status.

Ready Queue Displays Ready status.

Timeout Queue Displays Timeout status.

Event Flag Displays Event Flag status.

Semaphore Displays Semaphore status.

Mailbox Displays Mailbox status.

Data Queue Displays Data Queue status.

Cyclic Handler Displays Cyclic Handler status.

Alarm Handler Displays Alarm Handler status.

Memory Pool Displays Memory Pool status.

Message Buffer Displays Message Buffer status.

Port Displays Port status.

Mailbox(with Priority) Displays Mailbox(with Priority) status.
Context... Displays Context.
Layout | Status Bar Switch display or non-display of status bar.
Refresh Refresh memory data.
RAM Monitor Enable RAM Monitor Switch enable or disable RAM Monitor function.

Sampling Period...

Set RAM Monitor sampling period.

Toolbar display

Display toolbar.

Customize toolbar...

Open toolbar customize dialog box.

Allow Docking

Allow window docking.

Hide

Hide window.
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5.7.2 Display the Task Status
In the MR window, select Popup Menu - [Mode] -> [Task].

MR =
WEOP=AHOTHS - WEE
Current Fun Task:[1] {_main}
0 | Stadddr | (name) | Pri | status | wmp count timeout | flog ptn | £lg wode ﬂ
1 OFLVFBH [_main) 1 RUN ooooE 0 ————=—  m———— e
Z OFlaeZH [_taski) 2 FRDY¥ ooooE 0 ————=  mm—e— e
3 OF1A7eH [ task3d) i1 googoE 0 ————= mm——— e
4 OF1A84H (_taskd) 1 WAI(SLE) O0O0H =~ o—=—mm mmmmm o
5 OF1A92H | taski) 1 WAI(SLP)-3US 0
6 OF1ABOH [_taske) 1 WAI(DLY) 0000H 7FFFH =~ ————— ———————
7 OF1ACAH [_task7) 1 WAI(DLE)-3US 0000H JFFFH =~ —————  ——m—m————
8 OF1AE4H | tasks) 1 WATII(FLG) goocg -mmm- 1111H TWF_ORT
._|_9| OF1BOZH [ taskd) 1 WAI(FLG)-3US ooooE 00 ————- 1111H TWF ORW _l;l
J »

By double-clicking any line, the information on the task context is displayed in the Context dialog.
For details on the Context dialog, see "5.7.12 Display the Task Context"
The following data is displayed in the status bar.

|Ourrent Fum Task:[1]  main}

5.7.2.1 Display the Task Status(When the realtime OS is MRxx conformed to uITRON specifications
v.3.0.)

All the tasks defined in the configuration are listed in the order of ID number. The function of each
item is as described below. (When the realtime OS is MRxx conformed to uITRON specifications
V.3.0.)

Ttems Contents

1D Task ID

StaAddr Starting address of task

(name) Task name

Pri Priority

Status*1 Task status

wup_count Wake-up count

timeout Timeout value

flg_ptn Wait bit pattern of event flag
flg_mode*2 Wait cancellation condition of event flag
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*1Task Status

Display Status

RUN RUNNING state
RDY READY state

SUS SUSPENDED state
DMT DORMANT state
WAI(SLP) Sleeping state

WAI(SLP)-SUS

Sleeping state (suspended)

WAI(SLP-TMO)

Sleeping state with time-out

WAI(SLP-TMO)-SUS

Sleeping state with time-out (suspended)

WAI(DLY) Delayed state due to dly_tsk
WAI(DLY)-SUS Delayed state due to dly_tsk (suspended)
WAI(FLG) Waiting state for an eventflag

WAI(FLG)-SUS

Waiting state for an eventflag (suspended)

WAI(FLG-TMO)

Waiting state for an eventflag with time-out

WAI(FLG-TMO)-SUS

Waiting state for an eventflag with time-out (suspended)

WAI(SEM) Waiting state for a semaphore resource
WAI(SEM)-SUS Waiting state for a semaphore resource (suspended)
WAI(SEM-TMO) Waiting state for a semaphore resource with time-out

WAI(SEM-TMO)-SUS

Waiting state for a semaphore resource with time-out (suspended)

WAI(MBX)

Receiving waiting state for a mailbox

WAI(MBX)-SUS

Receiving waiting state for a mailbox (suspended)

WAI(MBX-TMO)

Receiving waiting state for a mailbox with time-out

WAIMMBX-TMO)-SUS

Receiving waiting state for a mailbox with time-out (suspended)

*2Display the Wait Cancellation Condition of Event Flag

flg_mode

Status

TWF_ANDW

Waits for all bits set in the wait bit pattern to be set (AND wait)

TWF_ANDW+TWF_CL
R

Clears the event flag to 0 when an AND wait has occurred and the task
wait status has been cancelled

TWF_ORW

Waits for any one bit set in the wait bit pattern to be set (OR wait)

TWF_ORW+TWF_CLR

Clears the event flag to 0 when an OR wait has occurred and the task
wait status has been cancelled
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5.7.2.2 Display the Task Status(When the realtime OS is MRxx conformed to uITRON specifications
V.4.0.)

All the tasks defined in the configuration are listed in the order of ID number. The function of each
item is as described below. (When the realtime OS is MRxx conformed to uITRON specifications
V.4.0.)

Ttems Contents

1D Task ID

Name Task name

Pri Priority

Status*1 Task status

Wupcent Wake-up count

Actent Activated count

Tmout Timeout value

Flgptn Wait bit pattern of event flag
Wfmode*2 Wait cancellation condition of event flag
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e  *]Task Status

Display Status

RUN RUNNING state
RDY READY state

SUS SUSPENDED state
DMT DORMANT state
WAI(SLP) Sleeping state

WAI(SLP)-SUS

Sleeping state (suspended)

WAI(SLP-TMO)

Sleeping state with time-out

WAI(SLP-TMO)-SUS

Sleeping state with time-out (suspended)

WAI(DLY) Delayed state due to dly_tsk
WAI(DLY)-SUS Delayed state due to dly_tsk (suspended)
WAI(FLG) Waiting state for an eventflag

WAI(FLG)-SUS

Waiting state for an eventflag (suspended)

WAIL(FLG-TMO)

Waiting state for an eventflag

WAI(FLG-TMO)-SUS

Waiting state for an eventflag (suspended)

WAI(SEM)

Waiting state for a semaphore resource

WAI(SEM)-SUS

Waiting state for a semaphore resource (suspended)

WAI(SEM-TMO)

Waiting state for a semaphore resource with time-out

WAI(SEM-TMO)-SUS

Waiting state for a semaphore resource with time-out (suspended)

WAI(MBX)

Receiving waiting state for a mailbox

WAI(MMBX)-SUS

Receiving waiting state for a mailbox (suspended)

WAI(MBX-TMO)

Receiving waiting state for a mailbox with time-out

WAI(MMBX-TMO)-SUS

Receiving waiting state for a mailbox with time-out (suspended)

WAI(SDTQ)

Sending waiting state for a data queue

WAI(SDTQ)-SUS

Sending waiting state for a data queue (suspended)

WAI(SDTQ-TMO)

Sending waiting state for a data queue with time-out

WAI(SDTQ-TMO)-SUS

Sending waiting state for a data queue with time-out (suspended)

WAIRDTQ)

Receiving waiting state for a data queue

WAI(RDTQ)-SUS

Receiving waiting state for a data queue (suspended)

WAI(RDTQ-TMO)

Receiving waiting state for a data queue with time-out

WAIRDTQ-TMO)-SUS

Receiving waiting state for a data queue with time-out (suspended)

WAI(VSDTQ)

Sending waiting state for an extended data queue

WAI(VSDTQ)-SUS

Sending waiting state for an extended data queue (suspended)

WAI(VSDTQ-TMO)

Sending waiting state for an extended data queue with time-out

WAI(VSDTQ-TMO)-SUS

Sending waiting state for an extended data queue with time-out
(suspended)

WAI(VRDTQ)

Receiving waiting state for an extended data queue

WAI(VRDTQ)-SUS

Receiving waiting state for an extended data queue (suspended)

WAI(VRDTQ-TMO)

Receiving waiting state for an extended data queue with time-out

WAI(VRDTQ-TMO)-SUS

Receiving waiting state for an extended data queue with time-out

(suspended)
WAI(MPF) Waiting state for a fixed-sized memory block
WAI(MPF)-SUS Waiting state for a fixed-sized memory block (suspended)
WAI(MPF-TMO) Waiting state for a fixed-sized memory block with time-out

WAI(MMPF-TMO)-SUS

Waiting state for a fixed-sized memory block with time-out
(suspended)
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e  *2Display the Wait Cancellation Condition of Event Flag

Wfmode Status
TWF_ANDW Waits for all bits set in the wait bit pattern to be set (AND wait)
TWF_ORW Waits for any one bit set in the wait bit pattern to be set (OR wait)

5.7.3 Display the Ready Queue Status

In the MR window, select Popup Menu - [Mode] -> [Ready Queuel.

MR x|

WO P OTHOS-WEE

Current Run Tazk:[1] main |Number of Priority:100

Eri | Bdyo
1 1( main)
2 2( taskz)

5 15| taskl5)
10 16( taskle)
15 17( _task1?)
20 181 taskls)

<] | i

The following data is displayed in the status bar.

Current Fun Task:[1] { main |Num|:uer of Priority:100

5.7.3.1 Display the Ready Queue Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.3.0.)

The function of each item is as described below. (When the realtime OS is MRxx conformed to
ulTRON specifications V.3.0.)

Ttem Contents
Pri Displays priority
RdyQ Shows the ID Nos. and task names of tasks in the ready queue

e  Up to 8 characters of the task name is displayed in the RdyQ field. When the task name exceeds 8
characters, the extra characters are omitted.

5.7.3.2 Display the Ready Queue Status(When the realtime OS is MRxx conformed to uITRON
specifications V.4.0.)

The function of each item is as described below. (When the realtime OS is MRxx conformed to
ulTRON specifications V.4.0.)

Item Contents
Pri Displays priority
Ready Queue Shows the ID Nos. and task names of tasks in the ready queue

e  Up to 8 characters of the task name is displayed in the Ready Queue field. When the task name
exceeds 8 characters, the extra characters are omitted.
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5.7.4 Display the Timeout Queue Status

In the MR window, select Popup Menu - [Mode] -> [Timeout Queue].

MR,

wioP=@u ODTHL«PEE

Value | ID [name |

TOFFH
TFOOH
TFOFH
TFFOH
TFFFH
TFFFH
TFFFH

21( taskz1) [dly]
24( taskz4) [dly]
22| task22) [dly]
23 _task23) [dly]
61 tasks) [dly]

T _task¥) [dly] [=]

20 taskz0) [dly]

5.7.4.1 Display the Timeout Queue Status(When the realtime OS is MRxx conformed to uITRON

specifications V.3.0.)

The function of each item is as described below.
Tasks waiting at present are displayed in the descending order of timeout value. (When the realtime
0S8 is MRxx conformed to uITRON specifications V.3.0.)

Ttem Contents
Value Shows the timeout value of each task
ID(name) Shows the ID No. and task name of the tasks in the timeout queue

e Following character strings are used to indicate the type of wait state.

Character string Wait state

[slp] Wait due to tslp_tsk
[dly] Wait due to dly_tsk
[flg] Wait due to twai_flg
[sem] Wait due to twai_sem
[mbx] Wait due to trcv_msg

e  When a task connected to the timeout queue is in the state of forced waiting (double waiting), a
string "[s]", which indicates double waiting, is appended to a string displayed in the ID (name)

field.
Normal display 26(_task26)
Display when in WAIT-SUSPEND 26(_task26)[s]
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5.7.4.2 Display the Timeout Queue Status(When the realtime OS is MRxx conformed to ulTRON

specifications V.4.0.)

The function of each item is as described below.

Tasks waiting at present are displayed in the descending order of timeout value. (When the realtime
08 is MRxx conformed to uITRON specifications V.4.0.)

Ttem Contents
Tmout Shows the timeout value (ms) of each task
ID(Name) Shows the ID No. and task name of the tasks in the timeout queue

e Following character strings are used to indicate the type of wait state.

Character string

Wait state

[slp] Wait due to tslp_tsk
[dly] Wait due to dly_tsk
[flg] Wait due to twai_flg
[sem] Wait due to twai_sem
[mbx] Wait due to trev_mbx
[mpf] Wait due to tget_mpf
[sdtql Wait due to tsnd_dtq
[rdtq] Wait due to trev_dtq
[vsdtq] Wait due to vtsnd_dtq
[vrdtq] Wait due to vtrev_dtq

e  When a task connected to the timeout queue is in the state of forced waiting (double waiting), a
string "[s]", which indicates double waiting, is appended to a string displayed in the ID(Name)

field.
Normal display 26(_task26)
Display when in WAIT-SUSPEND 26(_task26)ls]
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5.7.5 Display the Event Flag Status

In the MR window, select Popup Menu - [Mode] -> [Event Flag].

MR x|
WO P=HEDTHS -0 EEE

| flg_ptnl flagd

0000H 8I_tasks)
D000H

0000H 91 taskd) (=]
0000H

0000H

0000H

0000H

[« | H

=1 N e Wk

5.7.5.1 Display the Event Flag Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.3.0.)

All the event flags defined in the configuration are listed in the order of ID number. The function of
each item is listed below. (When the realtime OS is MRxx conformed to ulTRON specifications V.3.0.)

Ttem Contents

1D ID No. of event flag

flg_ptn Bit pattern of each event flag

flagQ Task ID Nos. and task names in the event flag queue

e  When a task connected to the event flag queue is in the state of waiting with timeout enabled
(waiting in twai_flg), a string "[tmo]", which indicates a state of waiting with timeout enabled, is
appended to a string displayed in the flag Q field.

When a task connected to the event flag queue is in the state of forced waiting (double waiting), a
string "[s]", which indicates double waiting, is appended to a string displayed in the flag Q field.

Normal Display 26(_task26)

Display when in WAIT-SUSPEND 26(_task26)[s]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmoll[s]

e  Up to 8 characters can be displayed in the task name in the flag Q field. If a task name exceeds 8
characters, the extra characters are omitted.
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5.7.5.2 Display the Event Flag Status(When the realtime OS is MRxx conformed to ulTTRON
specifications V.4.0.)

All the event flags defined in the configuration are listed in the order of ID number. The function of
each item is listed below. (When the realtime OS is MRxx conformed to ulTRON specifications V.4.0.)

Ttem Contents

1D ID No. of event flag

Flgatr Attribute of each event flag

Flgptn Bit pattern of each event flag

Flag Queue Task ID Nos. and task names in the event flag queue

e The following are displayed in the Flgatr area:

TA_TFIFO Task wait queue is in FIFO order

TA_TPRI Task wait queue is in task priority order

TA_WSGL Only one task is allowed to be in the waiting state for the eventflag

TA_WMUL Multiple tasks are allowed to be in the waiting state for the eventflag

TA_CLR Eventflag's bit pattern is cleared when a task is released from the
waiting state for that eventflag

e  When a task connected to the event flag queue is in the state of waiting with timeout enabled
(waiting in twai_flg), a string "[tmo]", which indicates a state of waiting with timeout enabled, is
appended to a string displayed in the Flag Queue field.

When a task connected to the event flag queue is in the state of forced waiting (double waiting), a

string "[s]", which indicates double waiting, is appended to a string displayed in the Flag Queue
field.

Normal Display 26(_task26)
Display when in WAIT-SUSPEND 26(_task26)ls]
Display when in WAIT-SUSPEND with time out | 26(_task26)[tmo]ls]

e Up to 8 characters can be displayed in the task name in the Flag Queue field.
If a task name exceeds 8 characters, the extra characters are omitted.
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5.7.6 Display the Semaphore Status

In the MR window, select Popup Menu - [Mode] -> [Semaphore].

MR E3
WEOPmAUOTHO-HED S
10 | Def cnt | count | semo

1 0000H 0000H  10(_taskl0y, 11( taskll)[=]
2 0D003H 0003H
3 000sH 0003H
4  0005H 0005H
3 0007H 0007H
& OO00ZH 0002ZH
7 0003H 0003H

[« | H

5.7.6.1 Display the Semaphore Status(When the realtime OS is MRxx conformed to uITRON
specifications V.3.0.)

All the SEMs defined in the configuration are listed in the order of ID number. The function of each
item is listed below. (When the realtime OS is MRxx conformed to uITRON specifications V.3.0.)

Ttem Contents

1D ID No. of semaphore

Def_cnt Default value of semaphore counter

Count Semaphore count

semQ@ Task ID Nos. and task names in the semaphore queue

e  When a task connected to the SEM queue is in the state of waiting with timeout enabled (waiting
in twai_sem), a string "[tmo]", which indicates a state of waiting with timeout enabled, is
appended to a string displayed in the semQ field.

When a task connected to the SEM queue is in the state of forced waiting (double waiting), a
string "[s]", which indicates double waiting, is appended to a string displayed in the semQ field.

Normal Display

26(_task26)

Display when in WAIT-SUSPEND 26(_task26)ls]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmoll[s]

e Up to 8 characters can be displayed in the task name in the semQ field.
If a task name exceeds 8 characters, the extra characters are omitted.
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5.7.6.2 Display the Semaphore Status (When the realtime OS is MRxx conformed to ulTRON

specifications V.4.0.)

All the SEMs defined in the configuration are listed in the order of ID number. The function of each
item is listed below. (When the realtime OS is MRxx conformed to uITRON specifications V.4.0.)

Ttem Contents

1D ID No. of semaphore
Sematr Attribute of each semaphore
Semcnt Semaphore count

Semaphore Queue

Task ID Nos. and task names in the semaphore queue

e The following are displayed in the Sematr area:

TA_TFIFO

Task wait queue is in FIFO order

TA_TPRI

Task wait queue is in task priority order

e  When a task connected to the SEM queue is in the state of waiting with timeout enabled (waiting
in twai_sem), a string "[tmo]", which indicates a state of waiting with timeout enabled, is
appended to a string displayed in the Semaphore Queue field.

When a task connected to the SEM queue is in the state of forced waiting (double waiting), a
string "[s]", which indicates double waiting, is appended to a string displayed in the Semaphore

Queue field.
Normal Display 26(_task26)
Display when in WAIT-SUSPEND 26(_task26)[s]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmoll[s]

e Up to 8 characters can be displayed in the task name in the Semaphore Queue field.If a task
name exceeds 8 characters, the extra characters are omitted.
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5.7.7 Display the Mailbox Status

In the MR window, select Popup Menu - [Mode] -> [Mailbox].

M ER

WEQOP=HguOTHE-PEE

I | Msog cnt | MAXmSo |

WaitQueue (Message)

0ooo0H CO0AH
0O0Z2H 0014H
CoooH CO0AH
0ooo0H 0O3CH
0ooo0H OOZ2H
0oo0o0H CO0FH
CoooH COZ8H

=] o b W

[« |

Task 1Z(_taskli)
Msg 0033H, 0055H
Task 13 [ _taskl3) [s]

5.7.7.1 Display the Mailbox Status (When the realtime OS is MRxx conformed to uITRON

specifications V.3.0.)

All the mail boxes defined in the configuration are listed in the order of ID number. The function of
each item is listed below. (When the realtime OS is MRxx conformed to ulTRON specifications V.3.0.)

Ttem Contents

1D ID No. of mailbox

Msg _cnt Number of messages in each mailbox

MAXmsg Maximum number of messages that can be contained in each mailbox

Wait Queue(Message) The messages stored in the mailbox or ID No. and task name of tasks
waiting for messages

o The WaitQueue (Message) field shows a string "Msg" when a message is stored (when Msg_cont
as described above is non-zero), and then displays the stored message.
When no message is stored (when Msg_cont is zero), the WaitQueue field displays a string "Task"
if a task waiting for a message exists, and then displays the ID number and name of the task

waiting for a message.

e  When a task connected to the mail box queue is in the state of waiting with timeout enabled
(waiting in trev_msg), a string "[tmo]", which indicates the state of timeout enabled, is appended
to a string displayed in the WaitQueue (Message) field.

When a task connected to the mail box queue is in the state of forced waiting (Double waiting), a
string "[s]", which indicates the state of double waiting, is appended to a string displayed in the

WaitQueue (Message) field.

Normal Display

26(_task26)

Display when in WAIT-SUSPEND

26(_task26)[s]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmoll[s]

e Up to 8 characters can be displayed in the task name in the WaitQueue (Message) field.
If a task name exceeds 8 characters, the extra characters are omitted.
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5.7.7.2 Display the Mailbox Status (When the realtime OS is MRxx conformed to uITRON

specifications V.4.0.)

All the mail boxes defined in the configuration are listed in the order of ID number. The function of
each item is listed below. (When the realtime OS is MRxx conformed to ulTRON specifications V.4.0.)

Ttem Contents
ID ID No. of mailbox
Mbxatr Attribute of each mailbox

Mailbox Queue (Wait)

ID No. and task name of tasks waiting for messages

Mailbox Queue (Message)

The messages stored in the mailbox

e The following are displayed in the Mbxatr area:

TA_TFIFO Task wait queue is in FIFO order
TA_TPRI Task wait queue is in task priority order
TA_MFIFO Message queue is in FIFO order

TA_MPRI Message queue is in message priority order

e  When a task connected to the mail box queue is in the state of waiting with timeout enabled
(waiting in trcv_mbx), a string "[tmo]", which indicates the state of timeout enabled, is appended
to a string displayed in the Mailbox Queue (Wait) field.

When a task connected to the mail box queue is in the state of forced waiting (Double waiting), a
string "[s]", which indicates the state of double waiting, is appended to a string displayed in the

Mailbox Queue (Wait) field.

Normal Display

26(_task26)

Display when in WAIT-SUSPEND

26(_task26)ls]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmo]ls]

o Up to 8 characters can be displayed in the task name in the Mailbox Queue (Wait) field.
If a task name exceeds 8 characters, the extra characters are omitted.
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5.7.8 Display the Data Queue Status

In the MR window, select Popup Menu - [Mode] -> [Data Queue].

MR

%]
BEOPmHuOTHOCIBEY
ID | DEgate | Dtcnt| thsz| Data Queus (Wit | Data Queus [(Data
[32]1 Ta_TFIFC O u] Send 23 (_teaskZ3d), 24| taskz4) [s], Z5
[32]2 Ta _TFIFO O u} Receive Z7(_taskiZ7), Z8(_taskis)[s],
[16]1 Ta TFIFD O u] Send 31(_task3l), 3Z(_taskii)[s], 33
[le]2 TA_TFRI u} u} Receive 35(_task3i3), 36(_taskie)[s],
KNI i

5.7.8.1 Display the Data Queue Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.4.0.)

All the data queues defined in the configuration are listed in the order of ID number. The function of
each item is listed below. (When the realtime OS is MRxx conformed to ulTRON specifications V.4.0.)

Ttem Contents

ID ID No. of data queue

Dtqatr Attribute of each date queue

Dtent Number of messages in each data queue

Dtqgsz Maximum number of messages that can be contained in each data queue

Data Queue (Wait) ID No. and task name of tasks waiting for message transmission waiting
or message reception waiting

Data Queue (Data) The messages stored in the data queue

e The display of the ID field varies depending on which one is specified, the standard data(32 bits)
or the extended data(16 bits).
MR308/4
- If the standard data(32 bits), the ID field displays a string "[32]" and data queue ID number.
- If the extended data(16 bits), the ID field displays a string "[16]" and data queue ID number.
MR30/4
- If the standard data(16 bits), the ID field displays a string "[16]" and data queue ID number.
- If the extended data(32 bits), the ID field displays a string "[32]" and data queue ID number.
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e The following are displayed in the Dtgatr area:

TA_TFIFO Task wait queue is in FIFO order

TA_TPRI Task wait queue is in task priority order

e The Data Queue (Wait) field displays a string "Send" if a task waiting for a message sending, and
then displays the ID number and name of the task waiting for a message sending. Also, if a task
waiting for a message receiving, displays a string "Receive" and then displays the ID number and
name of the task waiting for a message receiving.

e  When a task connected to the date queue is in the state of waiting with timeout enabled , a string
"[tmo]", which indicates the state of timeout enabled, is appended to a string displayed in the
Data Queue (Wait) field.

When a task connected to the data queue is in the state of forced waiting (Double waiting), a
string "[s]", which indicates the state of double waiting, is appended to a string displayed in the
Data Queue (Wait) field.

Normal Display 26(_task26)

Display when in WAIT-SUSPEND 26(_task26)ls]

Display when in WAIT-SUSPEND with time out | 26(_task26)[tmoll[s]

o Up to 8 characters can be displayed in the task name in the Data Queue (Wait) field.
If a task name exceeds 8 characters, the extra characters are omitted.
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5.7.9 Display the Cycle Handler Status
In the MR window, select Popup Menu - [Mode] -> [Cyclic Handler].

MR,

WMiOP=fHuOTHLCOEEE

I0 | Staiddr | (name) | interwal | count | Status |
1 O0OF1cSeH  (_cyolel) 00&64H 0064H TCY _ON
2 O0F1C38H [ _cyclel) O03EEH O3E8H TCY_OFF
3 O0F1c3AH [ cycled) D1F4H 01F4H TCY ON
4 O0FI1CSCH [_cyoled) 0Z58H QZ58H TCY_ON
53 O0FI1C5SEH  |_ecyolel) 00c8H 0OCEH TCY_OFF
& OF1CeDH [ _cyclef) 01ZcH D12CH To¥_ON
7 OF1c6ZH [ cycled) 0190H 0190H TCY ON
% O0Flced4H [ _cyoled) 015EH O1SEH TCY _ON

5.7.9.1 Display the Cycle Handler Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.3.0.)

All the cycle handlers defined in the configuration are listed in the order of ID number. The function
of each item is listed below. (When the realtime OS is MRxx conformed to uITRON specifications
v.3.0.)

Ttem Contents

ID ID No. of cycle handler

StaAddr Starting address of cycle handler
(name) Name of cycle handler

interval Interrupt interval

count Interrupt count

Status Activity status of cycle start handler

e  The following are displayed in the Status area:

TCY_ON Cycle handler enabled

TCY_OFF Cycle handler disabled
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5.7.9.2 Display the Cycle Handler Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.4.0.)

All the cycle handlers defined in the configuration are listed in the order of ID number. The function
of each item is listed below. (When the realtime OS is MRxx conformed to uITRON specifications
V.4.0)

Ttem Contents

1D ID No. of cycle handler

Name Name of cycle handler

Cycphs The activation phase (by the millisecond)

Cyctim The activation cycle time (by the millisecond)

Tmout The amount of time by the millisecond remaining before the cyclic
handler's next activation time

Status Activity status of cycle start handler

e The following are displayed in the Status area:

TCYC_STA Cycle handler is in an operational state

TCYC_STP Cycle handler is in a non-operational state
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5.7.10 Display the Alarm Handler Status

In the MR window, select Popup Menu - [Mode] -> [Alarm Handler].

MR x|
WEO P DTHO-DEEE

Femain Handler:? { Mow System Clock Gount = Q000HO000H:O134&H
ID | Staiddr | (name) | 2larmTime
2 O0F1CeBH |_alarmz) 0O000H : 0000H : ABCDH
B OF1C70H [ alarmb) 0000H @ 1000H : 0003H
1 OFI1C6EH ([_alarml) Q000" : ABCDH : 1000H
7T OF1CTZH  [_alarm7) 0o0pH @ 0013H =@ 1001H
3 O0FI1C6AH |_alarmi) 0O0CDH @ 0003H = O003H
4 OF1cecH [ alarmd) 00CDH @ O003H : 0333H
3 O0FIC6EH [_alarm3) 00CDH @ OAAZH : 0001H

When the realtime OS is MRxx conformed to uITRON specifications V.3.0, the following data is
displayed in the status bar.

Remain Handler:? ¢ Now System Clock Count = 0000H:0000H0184H 3

5.7.10.1 Display the Alarm Handler Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.3.0.)

Of all the cycle start handlers defined in the configuration, only those which are not started yet at
present are listed in the ascending order of start time. The function of each item is listed below.
(When the realtime OS is MRxx conformed to uITRON specifications V.3.0.)

Item Contents

ID ID No. of alarm handler

StaAddr Starting address of alarm handler
(name) Name of alarm handler
AlarmTime Starting time of alarm handler

5.7.10.2 Display the Alarm Handler Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.4.0.)

Of all the cycle start handlers defined in the configuration, only those which are not started yet at
present are listed in the ascending order of start time. The function of each item is listed below.
(When the realtime OS is MRxx conformed to ulTRON specifications V.4.0.)

Ttem Contents

ID ID No. of alarm handler

Name Name of alarm handler

Almtim The amount of time by the millisecond remaining before the alarm
handler's activation time

Status Activity status of alarm handler

e The following are displayed in the Status area:

TALM_STA Alarm handler is in an operational state

TALM_STP Alarm handler is in a non-operational state
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5.7.11 Display the Memory Pool Status

In the MR window, select Popup Menu - [Mode] -> [Memory Pooll.

MR, | x]
WiOP=fHUOTHLcWEEE
ID | Baseaddr | Blk size | Total Elk cnt | Free Blk cnt (map)
[F]1 O007EZH a0 4 2 [ 1100)
[F]Z O00BFZH 10 10 9 (- 1111111110}
[F]3 000956H 30 16 15 (11111111111111104
[VI1({1l) OO18EcH 24 - 1
1(Z) 000000H 56 - ]
1(3) 000000H 1z0o - ]
1(4) 0O01A96H 248 - 6
<] | 2

5.7.11.1 Display the Memory Pool Status(When the realtime OS is MRxx conformed to ulTRON
specifications V.3.0.)

All the memory pools defined in the configuration are listed in the order of ID number. (The fixed
length data comes first, and the optional length data comes after the fixed length data.) The function
of each item is listed below. (When the realtime OS is MRxx conformed to uITRON specifications
v.3.0.)

Ttem Contents

ID ID No. of memory pool

BaseAddr Base address of memory pool

Blk_Size Block size of memory pool

Total Blk_cnt Tot a I block count of memory pool

Free Blk_cnt(map) Number of unused blocks and information on unused memory blocks
(bit information)

e The display of the ID field varies depending on which one is specified, fixed length or optional
length.
- If the data is of fixed length, the ID field displays a string "[F]" and memory pool ID number.
- For an arbitrary length, the contents displayed on the first line are the character string "[V]," a
memory pool ID number, and a block ID number. Displayed on the second to fourth lines are
the memory pool ID and block ID numbers. The block ID numbers are enclosed in parentheses.
e When specifying the optional length memory pool, "--" is displayed in the Total Mlk_cut field.
No bit information is displayed in the Free Blk_cnt (map) field.
e  When specifying the fixed-length memory pool, the display format of each bit in the memory block
information in Free Blk_cnt (map) is as shown below:

item Contents

'0' Memory block in use (busy)

"1 Memory block not in use (ready)
- No memory block
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5.7.11.2 Display the Memory Pool Status(When the realtime OS is MRxx conformed to ulTRON

specifications V.4.0.)

All the memory pools are listed in the order of ID number. The function of each item is listed below.
(When the realtime OS is MRxx conformed to ulTRON specifications V.4.0.)

Ttem Contents

1D ID No. of memory pool

Mplatr Attribute of each memory pool

Mpladr Base address of memory pool

Mplsz Size of memory pool

Blkent Total block count of fixed length memory pool

Fblkent Number of unused blocks and information on unused memory blocks

Memory Pool Queue

Displays the ID number and name of tasks waiting in the memory
pool.

e  The following are displayed in the Mplatr area:

TA_TFIFO

Task wait queue is in FIFO order

TA_TPRI

Task wait queue is in task priority order

e The display of the ID field varies depending on which one is specified, fixed length or optional

length.

- If the data is of fixed length, the ID field displays a string "[F]" and memory pool ID number.

- For an arbitrary length, the contents displayed on the first line are the character string "[V]," a
memory pool ID number, and a block ID number. Displayed on the second to fourth lines are
the memory pool ID and block ID numbers. The block ID numbers are enclosed in parentheses.
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5Windows/Dialogs

5.7.12 Display the Task Context

5.7.12.1 Display the Task Context

In the MR window, select Popup Menu - [Context...].

The Context dialog box is opened. The Context dialog box is used to reference/specify the context
information of the specified task.

You can also open the Context dialog box by double-clicking the data display area in the task state
display mode .

Cortext

Task ID: |14 Oy Set.
Context:

Task I = 14 taskl4d |
Status = WAI([SEM)

Priority = 15

PC: FFZBEB3

RO: 0000

Rl: 0001

RZ: 0000

R3: 0014 b
AQ: 000001

Al: 0OO0005C

SB: DDO40E hd

Cloge I

Enter the task ID number in the Task ID field and click the View button (or press the Enter key).

The context of the specified task appears in the Context field.

e If the task entered in the Task ID field is "RUN" or "DMT" when clicking the View button, the
context is not displayed. (In the Context field, only the task ID and task state are displayed.)

e If a task ID number which does not exist is entered in the Task ID field when clicking the View
button, an error occurs.
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5.7.12.2 Change the task context

Enter the task ID number in the Task ID field in the Context dialog and click the Set button. The Set
Context dialog is opened.
The Set Context dialog is used to set the specified context register value of the specified task.

Tazk ID = 14
Register: Ip;| LI
Walue: |1 EET]

0] 4 I Cancel I

Specify the register to be changed in the Register field list box and enter the value to be set in the
"Value:" field.

If an expression description set in the "Value:" field is wrong, or if the specified value is outside the
allowable range set for the specified register, an error occurs.
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6Table of Script Commands

6. Table of Script Commands

The following script commands are prepared.
The commands with yellow color displaying can be executed at run time.
The command to which "*" adheres behind is not supported according to the product.

6.1 Table of Script Commands (classified by function)

6.1.1 Execution Commands

Command Name Short Name | Contents

Go G Program execution with breakpoints

GoFree GF Free run program execution
GoProgramBreak* GPB Run target program with software break point
GoBreakAt* GBA Run target program with software break point
Stop Stops program execution

Status Checks the operating status of the MCU

Step S Halts for user input until the specified time has elapsed
Steplnstruction SI Step execution of instructions

OverStep (0] Overstep execution of source lines
OverSteplInstruaction (0] Overstep execution of instructions

Return RET Executes a source line return
Returnlnstruction RETI Executes an instruction return

Reset - Resets the target MCU

6.1.2 File Operation Commands

Command Name Short Name | Contents

Load L Downloads the target program

LoadHex LH Downloads an Intel HEX-format file
LoadMot* LM Downloads a Motorola S-format file
LoadSymbol LS Loads source line/ASM symbol information
Reload Re-downloads the target program
UploadHex UH Outputs data to an Intel HEX-format file
UploadMot* UM Outputs data to a Motorola S-format file
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6.1.3 Register Operation Commands

Command Name

Short Name

Contents

Register

R

Checks and sets a register value

6.1.4 Memory Operation Commands

Command Name Short Name | Contents

DumpByte DB Displays the contents of memory (in 1-byte units)
DumpWord* DW Displays the contents of memory (in 2-byte units)
DumpLword* DL Displays the contents of memory (in 4-byte units)
SetMemoryByte MB Checks and changes memory contents (in 1-byte units)
SetMemoryWord* MW Checks and changes memory contents (in 2-byte units)
SetMemoryLword* ML Checks and changes memory contents (in 4-byte units)
FillByte FB Fills a memory block with the specified data (in 1-byte units)
FillWord* FW Fills a memory block with the specified data (in 2-byte units)
FillLword* FL Fills a memory block with the specified data (in 4-byte units)
Move - Moves memory blocks

MoveWord* MOVEW Moves memory blocks(in 2-byte units)

6.1.5 Assemble/Disassemble Commands

Command Name Short Name | Contents

Assemble A Line-by-line assembly

DisAssemble DA Disassembles memory contents line by line
Module MOD Displays modules names

Scope Sets and checks the effective local symbol scope
Section SEC Checks section information

Bit* Checks and sets bit symbols

Symbol SYM Checks assembler symbols

Label Checks assembler labels

Express EXP Displays an assembler expression

6.1.6 Software Break Setting Commands

Command Name Short Name | Contents

SoftwareBreak SB Sets and checks software breaks
SoftwareBreakClear SBC Clears software breaks

SoftwareBreakClearAll SBCA Clears all software breaks

SoftwareBreakDisable SBD Disables software breakpoints
SoftwareBreakDisableAll | SBDA Disables all software breaks

SoftwareBreakEnable SBE Enables software breakpoints
SoftwareBreakEnableAll SBEA Enables all software breaks

BreakAt - Sets a software breakpoint by specifying a line No.
Breakln Sets a software breakpoint by specifying a function
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6Table of Script Commands

6.1.7 Script/Log File Commands

Command Name

Short Name

Contents

Script Opens and executes a script file

Exit Exits the script file

Wait Waits for an event to occur before command input
Pause Waits for user input

Sleep Halts for user input until the specified time has elapsed
Logon Outputs the screen display to a log file

Logoff Stops the output of the screen display to a log file

Exec Executes external application

6.1.8 Program Display Commands

Command Name

Short Name

Contents

Func Checks function names and displays the contents of
functions

Up* Displays the calling function

Down* Displays a called function

Where* Displays a function call status

Path Sets and checks the search path

AddPath Adds the search path

File Checks a filename and displays the contents of that file

6.1.9 C Language Debugging Commands

Command Name Short Name | Contents
Print Check value of specified C variable expression
Set Set specified data in specified C variable expression

6.1.10 Real-time OS Command

Command Name

Short Name

Contents

MR*

Displays status of realtime OS (MRxx)
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6.1.11 Utility Commands

Command Name Short Name | Contents

Radix Sets and checks the radix for numerical input
Alias Specifies and checks command alias definitions
UnAlias Cancels the alias defined for a command
UnAliasAll Cancels all aliases defined for commands
Version VER Displays the version No.

Date Displays the date

Echo Displays messages

CD Window open
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6Table of Script Commands

6.2 Table of Script Commands (alphabetical order)

Command Name Short Name | Contents

AddPath Adds the search path

Alias Specifies and checks command alias definitions

Assemble A Line-by-line assembly

Bit* Checks and sets bit symbols

BreakAt Sets a software breakpoint by specifying a line No.

Breakln Sets a software breakpoint by specifying a function

CD Specifies and checks the current directory

Date Displays the date

DisAssemble DA Disassembles memory contents line by line

Down* Displays a called function

DumpByte DB Displays the contents of memory (in 1-byte units)

DumpLword* DL Displays the contents of memory (in 4-byte units)

DumpWord* DW Displays the contents of memory (in 2-byte units)

Echo Displays messages

Exec Executes external application

Exit Exits the script file

Express EXP Displays an assembler expression

File Checks a filename and displays the contents of that file

FillByte FB Fills a memory block with the specified data (in 1-byte
units)

FillLword* FL Fills a memory block with the specified data (in 4-byte
units)

FillWord* FW Fills a memory block with the specified data (in 2-byte
units)

Func Checks function names and displays the contents of
functions

Go G Program execution with breakpoints

GoBreakAt* GBA Run target program with software break point

GoFree GF Free run program execution

GoProgramBreak* GPB Run target program with software break point

Label Checks assembler labels

Load L Downloads the target program

LoadHex LH Downloads an Intel HEX-format file

LoadMot* LM Downloads a Motorola S-format file

LoadSymbol LS Loads source line/ASM symbol information

Logoff Stops the output of the screen display to a log file

Logon Outputs the screen display to a log file

Module MOD Displays modules names

Move - Moves memory blocks

MoveWord* MOVEW Moves memory blocks(in 2-byte units)

MR* - Displays status of realtime OS (MRxx)

OverStep (0] Overstep execution of source lines

OverSteplInstruaction Ol Overstep execution of instructions

Path Sets and checks the search path

Pause Waits for user input

Print Check value of specified C variable expression.

Radix Sets and checks the radix for numerical input

Register R Checks and sets a register value

Reload Re-downloads the target program
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Reset - Resets the target MCU

Return RET Executes a source line return

Returnlnstruction RETI Executes an instruction return

Scope = Sets and checks the effective local symbol scope

Script = Opens and executes a script file

Section SEC Checks section information

Set - Set specified data in specified C variable expression
SetMemoryByte MB Checks and changes memory contents (in 1-byte units)
SetMemoryLword* ML Checks and changes memory contents (in 4-byte units)
SetMemoryWord* MW Checks and changes memory contents (in 2-byte units)
Sleep - Halts for user input until the specified time has elapsed
SoftwareBreak SB Sets and checks software breaks

SoftwareBreakClear SBC Clears software breaks

SoftwareBreakClearAll SBCA Clears software breaks

SoftwareBreakDisable SBD Disables software breakpoints
SoftwareBreakDisableAll | SBDA Disables all software breaks

SoftwareBreak Enable SBE Enables software breakpoints
SoftwareBreakEnableAll SBEA Enables all software breaks

Status - Checks the operating status of the MCU

Step S Step execution of source line

Steplnstruction SI Step execution of instructions

Stop - Stops program execution

Symbol SYM Checks assembler symbols

UnAlias - Cancels the alias defined for a command

UnAliasAll - Cancels all aliases defined for commands

Up* - Displays the calling function

UploadHex UH Outputs data to an Intel HEX-format file

UploadMot* UM Outputs data to a Motorola S-format file

Version VER Displays the version No.

Wait - Waits for an event to occur before command input
Where* - Displays a function call status
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TWriting Script Files

This debugger allows you to run script files in a Script Window. The script file contains the controls
necessary for automatically executing the script commands.

7.1 Structural Elements of a Script File

You can include the following in script files:

e  Script commands

e  Assign statements

e Conditional statements (f, else, endi)
Program execution branches to the statement(s) to be executed according to the result of the
conditional expression.

e Loop statements (while, endw)
A block of one or more statements is repeatedly executed according to the expression.

e break statement
Exits from the innermost loop.

e Comment statements
You can include comments in a script file. The comment statements are ignored when the script
commands are executed.

Specify only one statement on each line of the script file. You cannot specify more than one statement
on a line, or write statements that span two or more lines.

Notes

e  You cannot include comments on the same lines as script commands.

e  You can nest script files up to five levels.

e  You can nest if statements and while statements up to 32 levels.

e If statements must be paired with endi statements, and while statements with endw statements
in each script file.

¢ Expressions included in script files are evaluated as unsigned types. Therefore, operation cannot
be guaranteed if you use negative values for comparison in if or while statements.

e  You can specify up to 4096 characters per line. An error occurs if a line exceeds this number of
characters.

e When a script file containing illegal commands is automatically executed (when you select
[ Option | -> [Script]-> [ Run | from the Script Window menu after opening a script file, or click
the button in the Script Window), execution of the script file continues even after the error is
detected, except when the script line itself cannot be read. If an error is detected and the script
file continues to be executed, operation after detection of the error cannot be guaranteed.
Reliability cannot therefore be placed on the results of execution after an error has been detected.
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7.1.1 Script Command

You can use the same script commands that you enter in the Script Window. You can also call script
files from within other script files (nesting up to 10 levels).

7.1.2 Assign Statement

Assign statement s define and initialize macro variables and assign values. The following shows the
format to be used.

| $macro-variable = expression

e You can use alphanumerics and the underscore () in macro variable names. However , you
cannot use a numeric to start a macro variable name.

e  You can specify any expression of which the value is an integer between Oh and FFFFFFFFh to
be assigned in a macro variable. If you specify a negative number, it is processed as twos
complement.

e You can use macro variables within the expression.

Always precede macro variables with the "%" sign.

7.1.3 Conditional Statement

In a conditional statement, different statements are executed according to whether the condition is
true or false. The following shows the format to be used.

if ( expression )
statement 1
else
statement 2
endi

o If the expression is t rue (other than 0), statement 1 is executed. If false, (0), statement 2 is
executed.

e  You can omit the else statement. If omitted and the expression is false, execution jumps to the
line after the endi statement.

e if statements can be nested (up to 32 levels).

7.1.4 Loop Statement(while,endw) and Break Statement

In loop statements, execution of a group of statements is repeated while the expression is true. The
following shows the format to be used.

while ( expression )
statement
endw

e If the expression is t rue, the group of statements is repeated. If false, the loop is exited (and the
statement following the endw statement is executed).

e  You can nest while statements up to 32 levels.

e  Use the break statement to forcibly exit a while loop. If while statements are nested, break exits
from the inner most loop.
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TWriting Script Files

7.1.5 Comment statements

You can include comments in a script file. Use the following format.

| ;character string

e  Write the statement after a semicolon (;). You can include only spaces and tabs in front of the

semicolon

e Lines with comment statements are ignored when the script file is executed.

7.2 Writing Expressions

This debugger allows you to use expressions for specifying addresses, data, and number of passes, etc.

The following shows example commands using expressions.
>DumpByte TABLEl
>DumpByte TABLE1+20

You can use the following elements in expressions:

e Constants

Symbols and labels
Macro variables
Register variables
Memory variables
Line Nos.
Character constants

e  Operators

7.2.1 Constants

You can use binary, octal, decimal, or hexadecimals. The prefix or suffix symbol attached to the
numerical value indicates which radix is used.
The debugger for M32C and M16C/R8C and 740

Hexadecimal Decimal Octal Binary *
Prefix 0x,0X @ None %
Suffix h,H None 0,0 b,B
Examples 0xAB24 @1234 12340 %10010

AB24h 10010b

*You can only specify % when the predetermined radix is hexadecimal.

e If you are inputting a radix that matches the predetermined radix, you can omit the symbol that

indicates the radix (excluding binary).

e Use the RADIX command to set the predetermined value of a radix. However, in the cases shown
below, the radix is fixed regardless of what you specify in a RADIX command.

No. of executions
No. of passes

Type Radix
Address Hex
Line No. Dec

101




7.2.2 Symbols and labels

You can include symbols and labels defined in your target program, or symbols and labels defined

using the Assemble command.

e  You can include alphanumerics, the underscore (), period (), and question mark (?) in symbols
and labels. However, do not start with a numeric.

e  Symbols and labels can consist of up to 255 characters.

e Uppercase and lowercase letters are unique.

Product Name Notes
The debugger for M32R, e You cannot include the assembler structured instructions,
The debugger for M32C, pseudo instructions, macro instructions, operation code, or
The debugger for M16C/R8C, reserved words (SECTION, .BYTE, switch, if, etc.).
e You cannot use strings that start with two periods (.) for
symbols or labels.

7.2.2.1 Local label symbol and scope

This debugger supports both global label symbols, which can be referenced from the whole program
area, and local label symbols, which can only be referenced within the file in which they are declared.
The effective range of local label symbols is known as the scope, which is measured in units of object
files. The scope is switched in this debugger in the following circumstances:
e  When a command is entered
The object file that includes the address indicated by the program counter becomes the current
scope. When the SCOPE command is used to set the scope, the specified scope is the active scope.
e During command execution
The current scope automatically switches depending on the program address being handled by
the command.
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TWriting Script Files

7.2.2.2 Priority levels of labels and symbols

The conversion of values to labels or symbols, and vice versa, is subject to the following levels of
priority:

Conversion of address values

Local labels

Global labels

Local symbols

Global symbols

Local labels outside scope

Local symbols outside scope

S A

Conversion of data values
Local symbols

Global symbols

Local labels

Global labels

Local labels outside scope
Local symbols outside scope

SO WD e

Conversion of bit values

Local bit symbols

Global bit symbols

Local bit symbols outside scope

W o=e

7.2.3 Macro Variables

Macro variables are defined by assign statements in the script file. See Section"7.1.2 Assign

Statement " in the Reference part for details. Precede variables with '%' for use as macro variables.

e  You can specify alphanumerics and/or the underbar () in the variable name following the percent
sign (%). However , do not star t the names with a numeric.

e  You cannot use the names of registers as variable names.

e  Uppercase and lowercase letters are differentiated in variable names.

e  You can define a maximum of 32 macro variables. Once defined, a macro variable remains valid
until you quit the debugger.

Macro variables are useful for specifying the number of iterations of the while statement.
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7.2.4 Register variables

Register variables are used for using the values of registers in an expression. Precede the name of the
register with '%' to use it as a register variable. Use the following format. (The debugger for 740 can
use '_'instead of '%'. )

Product Name Register name

The debugger for M32C PC, USP, ISP, INTB, FLB, SVF, SVP, VCT,
DMDO0,DMD1, DCTO0, DCT1, DRCO, DRC1,
DMAO,DMA1, DCAO, DCA1, DRAO, DRA1,
ORO, OR1, OR2, OR3, 0AO, 0A1, OFB, 0SB <- Bank 0 Register
1RO, 1R1, 1R2, 1R3, 1A0, 1A1, 1FB, 1SB <- Bank 1 Register

The debugger for M16C/R8C PC, USP, ISP, SB, INTB, FLG
0RO, OR1, OR2, OR3, 0A0, 0A1, 0FB <- Bank 0 Register
1RO, 1R1, 1R2, 1R3, 1A0, 1A1, 1FB <- Bank 1 Register

Uppercase and lowercase letters are not unique in register names. You can specify either.

7.2.5 Memory variables

Use memory variables to use memory values in expressions. The format is as follows:

[Address].data-size

e  You can specify expressions in addresses (you can also specify memory variables).

o The data size is specified as shown in the following table. (The debugger for 740 doesn't support
four byte length.)

data Length Debugger Specification
1 Byte All Borb
2 Bytes The debugger for M32R Horh
Other Wor w
4 bytes The debugger for M32R Wor w
The debugger for M32R, M16C/R8C Lorl

Example: Referencing the contents of memory at address 8000h in 2 bytes
[0x8000] .W

e The default data size is word, if not specified.

7.2.6 Line Nos.

These are source file line Nos. The format for line Nos. is as follows:
#line no
#line_no. "source file name"

e  Specify line Nos. in decimal.

e You can only specify line Nos. in which software breaks can be set. You cannot specify lines in
which no assembler instructions have been generated, including comment lines and blank lines.

e If you omit the name of the source file, the line Nos. apply to the source file displayed in active
Editor(Source) Window.

e Include the file attribute in the name of the source file.

e Do not include any spaces between the line No. and name of the source file.
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TWriting Script Files

7.2.7 Character constants

The specified character or character string is converted into ASCII code and processed as a constant.

e Enclose characters in single quote marks.

e Enclose character strings in double quote marks.

e The character string must consist of one or two characters (16 bits max.). If more than two
characters are specified, the last two characters of the string are processed. For example, "ABCD"
would be processed as "CD", or value 4344h.

7.2.8 Operators

The table below lists the operators that you can use in expressions.

e  The priority of operators is indicated by the level, level 1 being the highest and level 8 the lowest.
If two or more operators have the same level of priority, they are evaluated in order from the left
of the expression.

Operator Function Priority level

O Brackets level 1

+, -, ~ Monadic  positive, monadic | level 2
negative, monadic logical NOT

*/ Dyadic multiply, dyadic divide level 3

+, - Dyadic add, dyadic subtract level 4

>> Right shift, left shift level 5

& Dyadic logical AND level 6

[, Dyadic logical OR, dyadic | level 7
exclusive OR

<, <=, > >= == != Dyadic comparison level 8
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8.1 Writing C/C++ Expressions

You can use C/C++ expressions consisting of the tokens shown below for registering C watchpoints

and for specifying the values to be assigned to C watchpoints.

Token Example

Immediate values 10, 0x0a, 012, 1.12, 1.0E+3
Scope ‘'name, classname::member
Mathematical operators + %1

Pointers w kR

Reference &

Sign inversion -

Member reference using dot operator Object.Member

Member reference using arrow

Pointer->Member, this->Member

Pointers to Members

Object.*var, Pointer->*var

Parentheses

G)

Arrays

Array[2], DArray[2] [3] , ...

Casting to basic types

(int), (char®), (unsigned long ¥), ...

Casting to typedef types

(DWORD), (ENUM), ....

Variable names and function names

var, i, j, func, ...

Character constants

‘A, ', ...

Character string literals

"abedef", "I am a boy.", ...

8.1.1 Immediate Values

You can use hexadecimals, decimals, octals as immediate values. Values starting with Ox are
processed as hexadecimals, those with 0 as octals, and those without either prefix as decimals.

Floating-point numbers can also be used to assign values to variables.

Notes

e  You cannot register only immediate values as C watchpoints.

e The immediate value is effective only when it is used in C/C++ language expressions that specify
C/C++ watchpoints or when it is used to specify the value to be assigned to those expressions.
When using floating-point numbers, operation cannot be performed on an expression like 1.0+2.0.
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8C/C++ Expressions

8.1.2 Scope Resolution

The scope resolution operator :: is available as following.

Global scope: :ivaliable name
1:x, ::val

Class scope: class name::member name, class name::class name::member name, e.g.
T: :member, A::B::member

8.1.3 Mathematical Operators

You can use the addition (+), subtraction (-), multiplication (¥), and division (/) mathematical
operators. The following shows the order of priority in which they are evaluated.
(*), (/), (#), (=)
Notes

e  There is no support currently for mathematical operators for floating point numbers.

8.1.4 Pointers

Pointers are indicated by the asterisk (*). You can use pointer to pointers **, and pointer to pointer to

*kE ote.

Examples: "*variable name", "**variable name", etc.

pointers

Notes

e Immediate values cannot be processed as pointers. That is, you cannot specify *0xE000, for
example.

8.1.5 Reference

References are indicated by the ampersand (&). You can only specify "&variable_name".
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8.1.6 Sign Inversion

Sign inversion is indicated by the minus sign (-). You can only specify "-immediate_value" or

"-variable_name". No sign inversion is performed if you specify 2 (or any even number of) minus signs.

Notes

e There is no support currently for sign inversion of floating point numbers.

8.1.7 Member Reference Using Dot Operator

You can only use "variable_name.member_name" for checking the members of structures and unions

using the
Example:

dot operator.

class T {
public:

int memberl;
char member2;
}i

class T t_cls;
class T *pt_cls

= &t_cls;

In this case, t_cls.memberl, (*pt_cls).member2 correctly checks the members.

8.1.8 Member Reference Using Arrow

You can only use "variable_name->member_name" for checking the members of structures and unions

using the
Example:

arrow.

class T {
public:

int memberl;
char member?2;
}i

class T t_cls;
class T *pt_cls

= &t_cls;

In this case, (&t_cls)->memberl, pt_cls->member2 correctly checks the members.
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8C/C++ Expressions

8.1.9 Pointers to Members

Pointers to members using the ".*" or "->*" operator can be refered only in the forms of variable
name .* member name or variable name ->* member name.
Example:

class T {

public:

int member;

}i

class T t_cls;

class T *pt_cls = &t_cls;

int T::*mp = &T::member;

In this case, t_cls.*mp and tp_cls->*mp can correctly reference the variable of pointer-to-member type.

Note

e Note that the expression *mp cannot considered as the variable of pointer-to-member type.

8.1.10 Parentheses

Use the '(' and ") to specify priority of calculation within an expression.

8.1.11 Arrays

You can use the ' [ ' and ' ] ' to specify the elements of an array. You can code arrays as follows:
"variable_name [ (element No or variable) ] ", "variable_ name [ (element_No or variable) ]
[ (element_No or variable) ] ", etc.

8.1.12 Casting to Basic Types

You can cast to C basic types char, short, int, and long, and cast to the pointer types to these basic
types. When casting to a pointer type, you can also use pointers to pointers and pointers to pointers to
pointers, etc.

Note that if signed or unsigned is not specified, the default values are as follows:

Basic type Default

char unsigned

short signed

int signed

long signed
Notes

e  Of the basic types of C++, casts to bool type, wchar_t type, and floating-point type (float or
double) cannot be used.
e (Casts to register variables cannot be used.
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8.1.13 Casting to typedef Types

You can use casting to typedef types (types other than the C basic types) and the pointer types to
them. When casting to a pointer type, you can also use pointers to pointers and pointers to pointers to
pointers, etc.

Notes

e  You cannot cast to struct or union types or the pointers to those types.

8.1.14 Variable Name

Variable names that begin with English alphabets as required
under C/C++ conventions can be used.

The maximum number of characters for variable name is 255.
And 'this' pointer is available.

8.1.15 Function Name

Function names that begin with English alphabets as required
under C conventions can be used.

Notes

e In the case of C++, no function names can be used.

8.1.16 Character Constants

You can use characters enclosed in single quote marks () as character constants. For example, 'A', 'b',
etc. These character constants are converted to ASCII code and used as 1-byte immediate values.

Notes

e  You cannot register character constants only as C watchpoints.

e  Character constants are valid only when used in a C/C++ expression that specifies a C
watchpoint, and when specifying a value to be assigned (character constants are processed in the
same manner as immediate values).

8.1.17 Character String Literals

You can use character strings enclosed in double quote marks (") as character string literals.
Examples are "abcde", "I am a boy.", etc.

Notes

e  Character string literals can only be placed on the right side of an assignment operator in an
expression. They can only be used when the left side of the assignment operator is a char array or
a char pointer type. In all other cases, a syntax error results.
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8.2 Display Format of C/C++ Expressions

C/C++ expressions in the data display areas of the C Watch Windows are displayed as their type
name, C/C++ expression (variable name), and result of calculation (value), as shown below.
The following describes the display formats of the respective types.

8.2.1 Enumeration Types

e  When the result (value) of calculation has been defined, its name is displayed.
(DATE) date = Sunday(all Radices)_

e If the result (value) of calculation has not been defined, it is displayed as follows:
(DATE) date = 16 (when Radix is in initial state)
(DATE) date = 0x10 (when Radix is hex)
(DATE) date = 0000000000010000B (when Radix is binary)

8.2.2 Basic Types

e  When the result of calculation is a basic type other than a char type or floating point type, it is
displayed as follows:
(unsigned int) i
(unsigned int) i
(unsigned int) i

65280 (when Radix is in initial state)
0xFF00 (when Radix is hex)
1111111100000000B (when Radix is binary)
e  When the result of calculation is a char type, it is displayed as follows:
(unsigned char) c = 'J' (when Radix is in initial state)
(unsigned char) c = 0x4A (when Radix is hex)
(unsigned char) c = 10100100B(when Radix is binary)

e When the result of calculation is a floating point, it is displayed as follows:

(double) d = 8.207880399131839E-304 (when Radix is in initial state)
(double) d = 0x10203045060708 (when Radix is hex)

(double) d = 0000000010..... 1000B (when Radix is binary)

(... indicates abbreviation)
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8.2.3 Pointer Types

e  When the result of calculation is a pointer type to other than a char* type, it is displayed in

hexadecimal as follows:
(unsigned int *) p = 0x1234(all Radices)

e  When the result of calculation is a char* type, you can select the display format of the string or a
character in the C Watch window's menu [Display String].

- string types
(unsigned char *) str

0x1234 "Japan" (all Radices)

- character types
(unsigned char *) str

0x1234 (74 'J') (all Radices)

1 When the result of calculation is a char* type, it is displayed as follows:
(unsigned char *) str = 0x1234 "Jap(all Radices)

If the string contains a non-printing code prior to the code to show the end of the string (0), it is
displayed up to the non-printing character and the closing quote mark is not displayed.

'+ indicating pointer type

: Ciatch
x| s e 2w Bl

atch | Local | File Local | Glabal |

¥ tne | Value
+lunsigned char *) str OxFOO0O (B89 'T')
- |struct DATA *| plata 0x408
—[struct DATA )} * [pData) Ox408
[gigned int) nID u}
+(unsigned char *) str OxFOO05 (83 's')

You can double-click on lines indicated by a '+' to see the members of that structure or union. The '+'
changes to a '-' while the members are displayed. To return to the original display, double click the
line, now indicated by the '-'.
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8C/C++ Expressions

8.2.4 Array Types

e  When the result of calculation is an array type other than a char [ ] type, the starting address is

displayed in hex as follows:
(signed int [10]) z = 0x1234 (all Radices)

e  When the result of calculation is a char [ ] type, it is displayed as follows:
(unsigned char [10]) str = 0x1234 "Japan" (all Radices)

If the string contains a non-printing code prior to the code to show the end of the string (0), it is

displayed up to the non-printing character and the closing quote mark is not displayed.
(unsigned char [10]) str = 0x1234 "Jap(all Radices)

Also if the string contains more than 80 characters, the closing quote mark is not displayed. When the
C/C++ expression is an array type as same as pointer type, a '+' is display to the left of the type name.
You can see the elements of the array by using this indicating. (for the details, refer to "8.2.3 Pointer
Types") When the number of the array elements is more than 100, the following dialog box open.
Specify the number of the elements in the dialog box.

Flease set array area.

Start: ||]

End:  [1023

ancel

The elements from the index specified in "Start" to the index specified in "End" are displayed. If you
specify the value more than the max index of the array, the value is regarded as max index of the
array. When you click the "Cancel" button, the elements are not displayed.

8.2.5 Function Types

e  When the result of calculation is a function type, the starting address is displayed in hex as

follows:
(void()) main = 0xFO000 (all Radices)

8.2.6 Reference Types

e  When the result of calculation is a reference type, the reference address is displayed in hex as

follows:
(signed int &) ref = 0xD038 (all Radices)

8.2.7 Bit Field Types

e  When the result of calculation is a bit field type, it is displayed as follows:
(unsigned int :13) s.f 8191 (when Radix is in initial state)
(unsigned int :13) s.f Ox1FFF (when Radix is hex)

(unsigned int :13) s.f 1111111111111B(when Radix is binary)
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8.2.8 When No C Symbol is Found

If the calculated expression contained a C symbol that could not be found, it is displayed as follows:
() x = <not active>(all Radices)

8.2.9 Syntax Errors
e  When the calculated expression contains a syntax error, it is displayed as follows:

() str*(p = <syntax error>(all Radices)
(where str*(p is the syntax error)

8.2.10 Structure and Union Types

e  When the result of calculation is a structure or union type, the address is displayed in hex as

follows:
(Data) v = 0x1234 (all Radices)

If, as in structures and unions, the C/C++ expression consists of members, a '+' is displayed to the left
of the type name (tag name).

1 L] N N N .
+ indicating structure or union

L bk

mx | f 5z @B

iatch | Local | File Local | Glabal |

P EV] | Value | =
Tlunsigned char *) str OxFOOO0 (89 '¥')
L 4 [unsigned char] *(str) a9 '¥!
+|lstruct DATA *) pData 0408
- [(struct Answer ) ans Ox8ZE b
[unsigned char] ch 100 'd!’
[signed int] nID 3980 LI

You can double-click on lines indicated by a '+' to see the members of that structure or union. The '+'
changes to a '-' while the members are displayed. To return to the original display, double click the
line, now indicated by the '-'. This function allows you to check the members of structures and unions.

Attention

If a variable is declared with the same name as the type definition name declared by typedef, you
cannot reference that variable.

o  Register Variables
When the result of calculation is a register variable, "register" is displayed to the left of the type name

as follows:
(register signed int) j = 100
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8C/C++ Expressions

9. Display the Cause of the Program Stoppage

If the program is stoped by the debug function, the cause of the stoppage is displayed in the Output

window or Status window ([Platform] sheet).

The contents of a display and the meaning of "the cause of the stoppage" are as follows.

Display The cause of the stoppage
Halt The stop by the [Halt Program] button/menu
S/W break Software break

Address match interrupt break

Address interrupt break

H/W event, Combination

Hardware break, logical combination AND or
AND(same time)condition was met

H/W event, Combination, Ax

Hardware break, logical combination OR
condition was met

(Ax: The event number of which condition was
met.)

H/W event, State transition, from xx

Hardware break, State Transition condition was
met
(from xx: previous state (start, statel, state2))

H/W event, State transition, Timeout

Hardware break, State Transition, Time Out
condition was met

H/W event, Access protect error

Protect break

Note

To be able to show the cause of break or not depends on the connected target. Some targets may

always show "Halt" or show "---".
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10. Attention

10.1 Common Attention

10.1.1 File operation on Windows

The following points should be noted:
1. File Name and Directory Name
- Operation is not guaranteed if your directory names and filenames include kanji.
- Use only one period in a filename.
2. Specify the File and Directory
- You cannot use "..." to specify two levels upper directories.
- You cannot use a network pathname. You must allocate a drive.

10.1.2 Area where software breakpoint can be set

The Internal RAM area and Internal ROM area can be designated for software breakpoint.
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10.1.3 Get or set C variables

If a variable is declared with the same name as the type definition name declared by typedef, you
cannot reference that variable.

Values cannot be changed for register variables.

Values cannot be changed for 64 bit width variables (long long, double, and so on).

Values cannot be changed for C/C++ expressions that do not indicate the memory address and
size.

For the sake of optimization, the C compiler may place different variables at the same address. In
this case, values of the C variable may not be displayed correctly.

Literal character strings can only be substituted for char array and char pointer type variables.
No arithmetic operations can be performed on floating point types.

No sign inversion can be performed on floating point types.

Casting cannot be performed on floating point types.

Casting cannot be performed on register variables.

Casting cannot be performed on structure types, union types, or pointer types to structure or
union types.

Character constants and literal character strings cannot contain escape sequences.

The following values can be substituted for the bit-fields.

- integer constants, character constants, and enumerators

- variables of bool types, characters types, integers types, and enumeration types

- bit-field

When the substituted value is larger than the size of the bit-field, it will be truncated.

The bit-field member allocated in the SFR area might not be transformed into a correct value.
While the target program is running, values of local variables and bit-fields cannot be modified.

10.1.4 Function name in C++

When you input the address using the function name in setting display address, setting break
points, and so on, you can not specify the member function, operator function, and overloaded
function, of a class.

You can not use function names for C/C++ expression

No script commands (e.g., breakin and func) can be used in which function names are specified
for arguments.

In address value specifying columns of dialog boxes, no addresses can be specified using function
names.

The pointers for a member function can not be referred correctly in C watch window.

10.1.5 Option settings for download modules

These options, which can be set in "Debug Settings" dialog box, are invalid for this debugger:

Offset : specified value is regarded as ‘0’
Access size : specified value is regarded as ‘1’
Perform memory verify during download : Not supported.
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10.1.6 Debugging multi modules

If you register two or more absolute module file in one session, you can download only one file in same
time.

If you register one absolute module file and one or more machine language file in one session, you can
download all file in same time.

10.1.7 Synchronized debugging

Synchronized debugging function is not available.

10.1.8 RAM monitor function

The RAM monitor function of this debugger is realized with memory dump. Real-time capability is
impaired when this function is used. Moreover, a setup of the display color by the access attribute
cannot be performed.

10.1.9 Line assemble function

You can specify the internal RAM area included in from 00000H to OFFFFH for the line assemble
function.

10.1.10 Unavailable debugging functions

This debugger does not support the Hardware break, Protect, Coverage, Trace, Time measurement,
and other functions which depend on the specification of emulator system. These functions are not
available.

10.1.11 Software break function

e The software break function uses the address match interrupt of an mcu. Therefore, the count of
break points depends of the connected mcu.

o If the PASS column of a Source Window is double-clicked, the pass counts (number of times
passed) can be specified.
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10.2 Attention of the M32C Debugger

10.2.1 Option of C Compiler/Assembler/Linker

The information may not be downloaded/debugged normally depending on the option designation of
the compiler, assembler, and linker.
Please refer to the following for the option specification.

Refer to "10.4 Options for compiler, assembler, and linker"

The compiler that can be used by M32C debugger:
e NCxx

o the IAR EC++ Compiler

e the IAR C Compiler
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10.3 Attention of the M16C/R8C Debugger

10.3.1 Options for compiler, assembler, and linker

The information may not be downloaded/debugged normally depending on the option designation of
the compiler, assembler, and linker.

Please refer to the following for the option specification.

Refer t0"10.4 Options for compiler, assembler, and linker"

The compiler that can be used by M16C/R8C debugger:
e NCxx

o the IAR EC++ Compiler

e the IAR C Compiler

e the TASKING C Compiler

10.3.2 TASKING C Compiler

When you debug programs compiled by the TASKING C Compiler "CCM16", the type of bit field is
fixed on "unsigned short int". Because CCM16 outputs the debug information for the type of bit field
as "unsigned short int."

10.3.3 Cautions for R8C/Tiny series

e  You can not use the R8C/12-17 group mcu, if '0' is written to the bit0 of FFFFH. If '0' is written,
please erase the flash ROM by a flash writer.
e  You can not debug the program which is using WDT, if the target mcu is R8C/10-17 group.
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10.4 Options for compiler, assembler, and linker

We do not evaluate other settings, so we can not recommend to append other options.

10.4.1 When Using NCxx

When -0, -OR or -OS option is specified at compilation, the source line information may not be
generated normally due to optimization, causing step execution to be operated abnormally.

To avoid this problem, specify -ONBSD (or -Ono_Break_source_debug) option together with -O, -OR or
-OS option.

In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.

10.4.2 When Using the IAR C Compiler (EW)

Please specify the project setting by following process.

1. The Setting in the IAR Embedded Workbench
When you select the menu [Project] -> [Options...], the dialog for "Options For Target " target
will open. In this dialog, please select the "XLINK" as category, and set the project setting.
- Output Tab
In the "Format" area, check the "Other" option, and select the "ieee-695" as "Output Format".
- Include Tab
In the "XCL File Name" area, specify your XCL file (ex: Inkm16c.xcl).
2. Edit the XCL file
Add the command line option "-y" to your XCL file. The designation of "-y" option varies
depending on the product.

Product Name -y Option
The debugger for M32C -ylmb
The debugger for M16C/R8C -ylmb

3. Build your program after the setting above.

In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.
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10.4.3 When Using the IAR C Compiler (ICC)

10.4.3.1 Specify the Option

Please compile according to the following procedures and link.

e At compilation
Specify the "-r" option.

e Before linking
Open the linker's option definition file (extension .xcl) to be read when linking and add
"-FIEEE695" and "-y" options. The designation of "-y" option varies depending on the product.

Product Name -y Option
The debugger for M32C -ylmb
The debugger for M16C/R8C -ylmb

e Atlink

Specify the linker's option definition file name using "-f" option.

In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.

10.4.3.2 Command Execution Examples

The following shows examples of entering commands depending on the product

e The debugger for M32C
>ICCMC80 -r filel.c<Enter>
>ICCMC80 -r file2.c<Enter>
>XLINK -o filename.695 -f 1lnkm80.xcl filel file2<Enter>

e  The debugger for M16C/R8C
>ICCM16C -r filel.c<Enter>
>ICCM16C -r file2.c<Enter>
>XLINK -o filename.695 -f lnkmlé6c.xcl filel file2<Enter>

The XCL file name varies depending on the product and memory model. For details, see the ICCxxxx
manual.
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10.4.4 When Using the TASKING C Compiler (EDE)

Please specify the project setting by following process.

1. Select menu - [EDE]->[C Compiler Option]->[Project Options...]. The "M16C C Compiler Options
[Project Name]" dialog opens.
Please set as follows by this dialog.
- Optimeze Tab
Please specify "No optimization" by Optimization level.
- Debug Tab
Please check only ""Enable generation of any debug information(including type checkeing)™
and "Genarate symbolic debug information".
2. Select menu - [EDE]->[Linker/Locator Options...]. The "M16C Linker/Locator Options [Project
Name]" dialog opens.
Please set as follows by this dialog.
- Format Tab
Please specify "IEEE 695 for debuggers(abs)" by Output Format.
3. Build your program after the setting above.

In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.
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10.4.5 When Using the TASKING C Compiler (CM)

10.4.5.1 Specify the Option

Please specify "-g" and "- 00" options when compiling.
In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.

10.4.5.2 Command Execution Examples

The following shows examples of entering commands.
>CM16 -g -00 filel.c<Enter>

10.4.6 When Using the IAR EC++ Compiler (EW)

Please specify the project setting by following process.

1. The Setting in the IAR Embedded Workbench
When you select the menu [Project] -> [Options...], the dialog for "Options For Target " target"
will open. In this dialog, please select the "XLINK" as category, and set the project setting.
- Output Tab
In the "Format" area, check the "Other" option, and select the "elf/dwarf" as "Output Format".
- Include Tab
In the "XCL File Name" area, specify your XCL file (ex: Inkm32cf.xcl).
2. Edit the XCL file
Add the command line option "-y" to your XCL file. The designation of "-y" option varies
depending on the product.

Product Name -y Option
The debugger for M32C -yspce
The debugger for M16C/R8C -yspe

3. Build your program after the setting above.

In the options other than the above-mentioned, the operation check is not done. Please acknowledge
that the options other than the above-mentioned cannot be recommended.
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